
Software Changes Document: CAM‐Duct

2.40.062 SP3 19MAP Software Version: Version LOK Code : Release Date : 30/09/2010

New Features

Move to Park Point
Added special feature "Park, No Absolute Motion to Zero". If checked the safe absolute motion back to zero is replaced with a 
move to the park point.

Tool Raise/Lower
Added special feature "Use Tool Raise/Lower Codes". If checked "M3"lower command is added before tool on, "M4" raise 
coommand is added after tool off.

Application Fixes

ASCII
Importing Job ASCII text format was failing to assign Insulation Material and Gauge specified in the import file.

Carry Over
Fixed carry over not working on free entry items and allow user to edit product lists already taken off in quick takeoff.

Database
Fixed duplicate specification/material entries when importing new services (caused by iniitialised rotary size on gauges).

Labels\Worksheets
Fixed labels/worksheets with graphical pattern views crashing if opus parts exist in the job.

MultiCAM post Processor ‐ MCAMGEN.VPL
1) Reinstate Go To ParK point capability, this was broken when marking support was added. 
2) Add tool global item TI02 "Edge Approach" to plasma tool.

NC File Number Tracking
Fix NC Tracker values for Range, Start At and Batch Step not being passed back to Job info.

Profiler ‐ Manual Slice
Added an improved version of logic used to extend central cuts across oversize seams to profiler manual slice operation, as 
done in auto oversize slice.

Quick Takeoff
Fixed crashes in quick takeoff if user enters/edits items with product lists.

Sub Assemblies
Fixed sub assembly editor prompting the user two times for Cancel.

Now allow dimensions not covered by product data to be assigned by a dynamic sub assembly.
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Pattern Fixes

Pattern Fixes
CID 839 (Circular Box on Straight) ‐ Reducer end diameter was not adjusted with DW/Insulation applied.

CID 970 (Circular Reducer + Holes) ‐ Was not using the diameter type option.

CID 37 (Rectangular Drop Junction) ‐ Radius throats were developed as straight lines when set to Imperial dimensioins.
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2.40.059 SP2 19MAP Software Version: Version LOK Code : Release Date : 31/08/2010

New Features

Post Processor
AMG Post Processor ‐ Added support for plasma marker tool ‐ "AMG machine apply M17 as mark on and M18 as mark off"

Application Fixes

Combined Straight
Fixed pattern 866 Option #15 Override, user was not able to cycle through the various types.

DXF Import ‐ Layer Mapping
If the DXF name is the same as one of our tool layer names, the layers now become mapped. This is an addition to checking if 
the DXF layer name is in the import layer mapping list.

Item Folders
Fixed create sub folder off 'item folders' actaully adding the new folder as a root element, not a child of item folders.

Oversize Seams
Oversize Seams
Fixed patterns with both Oval and Round pattern types not being assigned an oversize seam e.g. CID 133. Also added type 
setting for Square to Oval patterns, as these were set to apply rectangular oversize seams.

Rotary Nesting
NC File Number Tracking
Fixed typos introduced when Rotary Nesting was initially added. Sheet numbers are now ok between old and new jobs.

Stiffeners
Re‐enabled Stiffener Material, Tie Rods, Bolts and Corners on a CAM only system.

Straight (Cut)
Fixed pattern 1 Option #1 Straight Type, 4 parts was naming the last part development incorrectly.

Sub Assembly
Fixed create catalogue item from sub assembly which had been actioning the edit of the sub assembly.

Units
Fixed the entering of dimensions using feet, changed so no inch value required.

Worksheets
Fixed Pattern Item Print on worksheets that was coming out black when printing.

Write NC
NC File Number Tracking ‐ Fixed NC Tracker values for Range, Start At and Batch Step not being passed back to Job information.
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Pattern Fixes

Pattern Fixes
CID 7 (Rectangular Shoe) ‐ Fixed program exit on Redraw when option "Throat Type" is set to Radius

CID 523, 2523 (Circular Bend) ‐ when Centreline Input enabled, outside insulation was not drawing correctly.
CID 1, 35, 866 (Rectangular Straights) ‐ Hole developments in certain scenarious were missing when using offsets. e.g. 2L part 
developments.
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2.40.052 SP1 19MAP Software Version: Version LOK Code : Release Date : 05/08/2010

New Features

Annotation
Added support for Object Text commands to work on preselected items.

Post Processor
AXYZ Post Processor
Added support for Double Pass Grooving with a single angled knife.
Mazak Post Processor ‐ MAZAKGEN.VPL
Add Special Feature "Turn Profiler Off At End" ‐ if checked, outputs an M31 after M21 near end of NC file.

New Patterns\Enhancements

Pattern Enhancements
CID 846 ‐ (Oval Tap on Straight) ‐ Now supports right reducer (as per CID 1115/6)

Application Fixes

Autonest
Fixed program crash if selecting a remnant in Autonest.

Cost Breakdown
Changed Cost Breakdown dialogue so uses fixed spacing and also changed the font to Lucida Console.

Database Reading + Conversion
Using ITM files with STRICT matching enabled was forcing the specification to be added to the database multiple times, if the 
master database had a Default Material assigned to the spec.

Dialogs
Fixed pressing Escape on dialogs that have 3D Viewers, stopped them closing when the user just presses Esc. to cancel 
selection.

Free Entry Items
Fixed crash in Takeoff if user edits a Free Entry item and then attempts to click Redraw.

Insulation Specs
Fixed insulation specifications applying the wrong library of connectors to transitional items.

Invalid connectors
Fixed takeoff using invalid data for unused connectors.

Item Delevopments Base Quantity
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Fixed Base Quantity for Developments that was initialised/read from a job file.
Caused Developments that are set to Not Cut to be wrongly included when reporting item properties e.g. Area.

Item Reports
Fixed the "Available" filter.

Materials
Fixed insulation material links so that when selecting insulation in a drop down, the link to the insulation database appears as 
it should. 
Fixed a crash if current material deleted from the material link. 
Made changes to fix the way new or deleted material acts, for example; when prompting to copy/remove entries relating to all 
materials.

Multiple Item Properties
Fixed an item having invalid insulation stopping Multiple Item Properties working at all.

Notches
Notch Out Extensions ‐ When the connector turnover is negative and the extension is smaller than the metal removed by the 
turnover, introduced a change to shorten the adjacent seam sides and avoid leaving "tags" on the seams.

Onorm Patterns
Print Area ‐ Ensure that all ONorm dimensions that are based on pattern calculations eg Auto, Flat Left, Equal use the 
calculation result value not the calculation option number.

Part Labels
Rectangular Radius Offset Item Dimension list field within the label setup when set to "Display Real Values for Auto Data" now 
displays true values rather than a ‐1.

PDF Import
Fixed an issue with line thicknesses so that when zooming, lines are kept proportionate and not thick lined when zoomed out. 
Had been causing visibility issues in the viewer.
Fixed layering of different colours contained within PDFs. Now able to specify layer selection based on colour.

Post Processor
Mitsubishi Laser Post Processor ‐ MITSUBISHIGEN.VPL
Change code to ensure that cutting process always uses one of the 10 proceess defined in the controller. Removed all unwanted 
codes and functions.
Procomm Post Processor PROGEN.VPL
Text Printing ‐ Add checks for extra motion at the end of text print which was going outside the machine limits, and if necessary 
adjust text position so that motion ends inside these limits.

Price\Times Editors
Fixed potential crash in product listed price/times table editors if prodinfo columns are shown that have blank data.

Print Objects
Fixed Object Connector Location Z Top\Bottom crashing reports.

Profiles
Fixed Insulation and Hanger specifications to convert when creating extra profiles. Also introduced fix for Fabrication, 
Installation and Price Lists tables so they too are not deleted.

Rotary Nesting
Hole Developments ‐ Addedthe ability to apply any hole adjustments when creating rotary parts for nesting ‐ Flatbed parts get 
the hole adjustments applied when they are expanded for nesting.

Setup Services
Fixed editing a new button in the Service template editor reloading & losing the button just added.
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Specifications
Fixed dialogue that prompted to delete entries in the specification. Was deleting the entries for that material regardless of 
selecting No.

Splitters
Fixed an issued with the splitter positioning for Radius Bends. When using the "Use Small End For Splitters" option, this 
calculated the small end for the quantity of splitters but used the large end for there positions.

Takeoff
Fixed missing connector/seam numbers in Takeoff views. This now dsiplays with the number for example "C1=DM25 500x400" 
previously displayed without the number "C=DM25 500x400".

Trackit
1.) Fixed trackit trigger for status 0 not functioning.
2.) Fixed status combo not updating when the database path is changed.
3.) Added feature to grey out batch printing options when not relevant.

Write NC
Underburn
Fixed a typo causing Write NC to hang in an endless loop when checking for island that has overburn.
Ensure that Simplify Paramaters are valid if the user has not setup the paramaters using the dialog. Invalid parameters may 
cause islands to be lost from the NC if they are smaller than the Tolerance parameter.

Pattern Fixes

Pattern Fixes
CID 818, 837 (Double Saddle Shoe Flat Front, Double Shoe Cross) ‐ Damper holes were not cut correctly (missing; on wrong 
parts; no pierce or mark)
CID 927 (Filter Box) ‐ Fixed Left/Right parts that were being developed incorrectly due to C2 edge at the same Y level as C1.

CID 988 (Oval Branch on Flat) ‐ Fixed so that it uses Rectangular Specs instead of Oval.
CID 2 (Taper) ‐ Fixed Seam Cut Back being removed from extension at C1 end if the connectors Male and Female Cut Back length 
is set to "0" and the pattern option "Seam Cut Back" set to Auto.
CID 974 (Circular Flange) ‐ Fixed issue when using Manual slice on this pattern so that Oversize Seam allowance is applied.
CID 353 (Box Pattern) ‐ When ends developed in 4 rounded parts, had tiny hole in middle; added option to not have 90‐degrees 
notch in the corner of one per four parts, now applied to all 4 parts.
CID 8 (Rectangular Square to Round) ‐ Single holes added the hole development was incorrectly positioned.
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2.40.039 19MAP Software Version: Version LOK Code : Release Date : 24/06/2010

Application Fixes

Batch Processing
Fixed batch process scanning indicator not appearing but was completing the scan in the background.

Disabled background processing from prompting to save jobs when importing BIT files

Grip points
Priority now on grips so that annotation is the first available

Job Viewer Report
Print object "Job Viewer Report" will now obey the justification properties.

Overburn
Fixed Auto Overburn/Underburn not checking island size against Tool Contour Extents Breakpoints

Printing
Fixed the size of text (dimensions) when printing using an imperial database.

Quick Takeoff
Fixed potential crash with Quick Takeoff not deleting entries fully unless a refresh (F5 key) was pressed.

Stiffeners
Fixed users not seeing Ancillary Materials assigned to stiffeners if the Costing option was not enabled on their dongle but the 
Estimating option had been.

Swap Out
Fixed CAM/EST swap out so that if only the spec is changed during swap out we validate the material e.g. force koolduct 
material change from a galvanised
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2.40.036 19MAP Software Version: Version LOK Code : Release Date : 15/06/2010

New Features

3D Viewer
Added new command "ATTR" to allow user to display attributes of any item selected. Attributes configured by "ITEMDETAILS" 
command
New toolbar option and command for Takeoff Area "ADDAREA", allowing a selection of points to calculate the total area of a 
closed island. The closed island will be treated as a new item in Job Contents with the calcualted area allocated.
Added BOD,TOD to tool tip when the user hovers over a connector snap node and also allowed the "ITEMDETAILS" or "ITMD" 
command to be used in the viewer to determine what item properties to display when selecting an item.
Viewer In Viewer (VIV) ‐ New command "VIV" which allows the user to select items and view them in an isolated viewer. Any 
changes made (with some exceptions ie. delete) of these items will be transferred back to the main viewer when this dialogue is 
closed.
New command for the 3D viewer called "SETLOD" which prompts for the level of detail on a scale of 1‐5.
Added Fill Between Two Ends Command "F2E" or "FILL2ENDS" which uses design line logic to fill between 2 open ends when 
selected.

ANFACA Area
Add Version 3 of calculation that only gives different value for taper.
If one offset then it should use half the largest offset, if there are 2 offsets it should use the largest on the width and the largest 
on the depth.

Application loading
Optimised the application initialisation when executing with non‐global active profiles.

Auto Oversize
Added support for patterns adding oversize information 
a) To start from given point at at specified angle, 
b) from midpoint of connector end 
Updated oversize dialog to allow use of pattern auto oversize breakdown or default breakdown

Connector Slit Holes
Added ability to apply slit holes on corner lugs/ears. User can specify spacing and has control on position of holes. Straights 
made in 2xL can accommodate corner lugs by having MM, FF developments.

Costing Database
Added the ability to use a Specification custom filter when creating Fabrication and Installation times tables.

User can now assign a popup description for each of the value set tables within Fabrication and Installation table creation.

Costing Tab
Added new option for Life Span and also added extra Cost Types for Demolition and Relocation onto the Costing Tab of Item 
Properties.

Database Filtering
New feature that enables users to filter out data from collapsable databases such as Connector and Seam databases. Users 
can Right Click any of the header fields and select Filter.

Decoiler
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Forstner.DPL ‐ Decoiled Straights on Decoiler with B line.
a) Add method to check for stretchout too big and change the type as necessary. When duct is made on the B Line the
stretchout is limited to the coilwidth.
b) Now allows multi coil allocation and use of multiple standard lengths in Straight options

Design Line
Added 'Take off as' option on the right click of Service buttons in design line mode.

DWG Import
Added support for AutoCAD 2010 DWG format for importing 2D/3D proxy graphics as 3D Viewer underlays.

Elink ‐ Importing Various Formats
Added functionality to allow *.DWG, *.DWF, files to be E‐linked into a model.

Export DWG
User can now export the 3D Viewer model as a DWG file format using the DWGEXPORT command.

HASP Notice
IMPORTANT: Changes to MAP licensing now only allows HL type keys to be used when running this version and future releases 
of the software. We have now dropped support for HASP4 and Parallel keys and users are reminded that for information on 
Swapping out their keys, they should be contacting their local distributer/dealer. 

Please be aware that this update will install the SRM Drivers associated with these HL keys in order for you to obtain access to 
the latest version of the software.

ITM Links
Add ability to add links to item files; can only be setup via scripting and appears as a separate "links" tab in item folders.

Job Import Tool
Add ExtraFTime & ExtreETime to ASCII text import tool (Job import Tool) which can be used for adding to normal Fabrication 
and Installation times.
Added new item header field when importing ASCII text file to "Add" holes to the pattern. This checks if the pattern being used in
the import already has enough holes added, and adds what is needed (This will add dimensions and options).

Machine Cut Order
Added the option to move pierce points to left, right, top or bottom positions of the nest. useful for machines where the coil is 
fed in from the side of the machine.

Material Database
Added "For Machines" option in the Material database > Material propeties dialogue for specifying if the material is to be 
displayed in the Installed Machines > Tool Details dialogue.

Multi Service Fill
Implementation of elevation control for Multiple Service line (including auto/angled‐risers).

Merged Multi Service Fill command from CAD, allows a single design line to offset and fill based on item selection.

Created user interface for new Multi Service Fill toolbar selection.

"Offset" parameter added to line segments to allow entire frame to be 'lifted' for tee situation.

New Print Object
"Item Fitting Type" added to list of Print Objects for AddReport text (can be used to filter).

OpenGL
Removed depreciated non‐OpenGL drawing code ‐ OpenGL is now a minimum requirement.

Opus

10 58ofPage



Software Changes Document: CAM‐Duct

Fixed angle bug in Polar Array, now functions correctly. Fixed bug with dragging move and normal grips using node‐stretch.
Added option to specify by diameter during CIRCLE command and allow user toggle between diameter/radius modes.
User settings for TrueType font generation are now remembered.

Oversize Breakdown
Attempt to extend the first/last cuts of central islands across the oversize seam. If extension fails it will insert a cut to the 
nearest point on the outer island.

Post Processor
ART Post Processor ‐ ARTGEN2.VPL. 
Added Special Feature "No Late Traverse" to optionally allow rapid traverse to be done before selection of the new tool.
DYSS Post Processor ‐ DYSSGEN.VPL
Add special feature "Relative Arc Centres" so arcs can be written in absolute format as required by this controller
D6 Post Processor D6GEN.VPL
Reinstated Tool Option "TI91 Height Control Min Radius".

Print Objects
Additional print objects for tie rod/bolt/material/corners (per stiffening position).

Product Lists
Revamped product lists so that dim/option columns don’t use visible indexes ‐ this means unlocked dims can be skipped and 
fixes issues with new dims added on patterns with holes.
We now no longer reload catalogue lists all the time (use console command 'reloadprods' to force reload on old jobs). We 
cache similar lists instead of discarding them.

IMPORTANT NOTE: This change breaks all forwards compatability ‐ product definitions will be lost to old versions if items are 
seved in this version.

Rastor to Vector Import
Improved quality of imported files.

Reports
Added new print object named "Development Rotary Diameter" that can be used in reports which displays the diameter of each 
rotary nested part.
Added "Item Insulation Nett Cost" and "Item Insulation Gross Cost" to Exporting Item Data.
Each report now has the option to Override the default Printer assigned. Useful for creating a duplicate report and saving one 
as PDF. Available by Options interface of each report.

Revit Mapping
"Service Types" Added To "Revit Mappings" Functionality when utilising the Processrun command for import of Revit ‐ *.RIF files

Sections added to "Revit mapping" whilst importing *.RIF models.

Ignore Service Function Added To "Revit Mapping" functionality

Rotary Nesting
Added method to create labels for rotary nesting.

Added method to cut scrap larger than specified diameter into two pieces
Within Nest Prints, switches have been added to General tab of Nest Prints dialog to allow Flatbed and Rotary nest prints to be 
enabled/disabled.
Added Item Custom Data to the Machine Setup > Part Labels
New technology added for Rotary Nesting. Software can now create rotary part developments for round patterns. Support 
added to output NC code based on the TTE Post Processor.

Scripting
Added item.canrotary() and item.rotarynest = true/false to the scripting references
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Sections
Implemented new option for Retrofit % onto Section properties.

Service Editor
Optimised the service template editor to be quicker at initialising; so it doesn't copy every template, just in case the user 
cancels, it copies them as and when needed.

Service Information Print
Users can now print out Service information such as Service Template name, Button Mappings, Layering information and Offset 
rules applicable to each service.

Spool Drawing
Now have the ability to select a run/object and create multiple spool drawings. This creates new tabs in the 3D viewer that has 
dimension annotation applied automatically. The 3D Viewer commands for their creation is "SPOOLS" and "DSPL" is used to 
define which objects are required. Further Spool related commands can be found via the command list filtering for the word 
"Spool".

Step Down connectors
Support added to draw step down rectangular connectors in Takeoff views (CAD and CAM) and in the 3D job Viewer (CAM,EST).

Stiffeners
Revamped stiffeners to include breakpoint tables for ancillaries and rod data. Now allows advanced configuration to comply 
with specifications.

Takeoff Dialogue
Takeoff options added to the toolbar to provide more area to dispay the graphical elements.

Takeoff Views
New Takeoff Views introduced to provide the user with more flexibility and advanced settings on annotation, graphical 
elements,views, colour and textures.
Users can now double click the viewport to maximise or restore the original view.

Trimble Export
Added an option to hanger pattern to include the drop rod diameter in the description of the item in the export file for the 
trimble layout unit (*.mep & *.cnx only).
New TrimbleLayoutAPI_MEP.DLL for 32 and 64 bit (_MEPx64.dll) builds.
New file extension supported (*.MEP) that supports LINE entries when using sleeves, CID 149, 972 and 1972, the node points 
are extended by 6" (150mm) so the machine can track the points if the wall is moved.

Write NC
a) Added support for Grooving with Single Angle Knife in two passes.
b) Improved lead/stitch handling when the stitch is at start/end of an island.

New Patterns\Enhancements

New Patterns
CID 1171 (Rectangular Angled Straight)

CID 1172 (Radius Bend ‐ Angled ends)

CID 1174 (Partition Corner)

CID1173 (Circular Branch On Bend) ‐ Allows branch to be positioned anywhere on the segmented bend.

CID 1179 (Taper + Bend 2 Way)
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CID 1178 (Ductboard Sarajevo Taper)

CID 1166 (Rectangular Sloped Elbow)

CID 1167 (Rectangular Triple Offset Tee)

CID 1180 (Linear Radius Diffuser)

Pattern Enhancements
CID 59 (Segment) ‐ Added option to enter by Central or End Diameter dimension.

CID 2326 (Circular Branch On Bend) ‐ Now allows different top/bottom body diameters.

CID 933 (Circular Offset Reducer Cross) ‐ Added support for the development of reducer collars.

CID 399 (Rectangular Drop Cheek Bend) ‐ Now supports splitters.

CID 472 (Rectangular Double Offset) ‐ New option & dimension to input middle width.
CID 9 (Radius Offset) ‐ Added option "Wraps V Notch if Zero Radius" which allows user to specify whether to use a Marker or 
Vee Notch when having no Radius on Top and Bottom Wrappers.
CID 397 (Insulation Cladding Valve Box) ‐ Now supports add hole.

CID 329 (Rectangular Parker) ‐ New option added to develop in 3 parts with no hole.

CID 51 (Circular Reducer) ‐ Added graining angle option.

CID 1166 (Rectangular Sloped Elbow) ‐ Added developments' break info (angles).

CID 394 (Circular Elbow) ‐ Added option to define the number of splitters.
CID 61 (Segment Bend) ‐ Modified the Single Segments option to allow only the development of end segments or middle 
segments if required e.g. as filler parts for rotary nesting.
CID 929 (Kymen Macro) ‐ Added a new dimension for the back holes’ offset; front/back options to offset from top instead of 
"centre".
CID 2965 (Circular Tee with Reducers) ‐ Branch length now taken from the pipe axis when using the Centreline Input option.

CID151 (Rectangular Angled Taper) ‐ Now supports double wall.

CID 399 (Rectangular Drop Bend) ‐ Now supports Splitters.

CID 6, 330 (Reducing Offset, Radius 2‐way Offset) ‐ Now support stiffeners.

CID 965/2965 (Circular Tee Reducer) ‐ Added centre‐line and option for left/right lengths to include extensions.

Application Fixes

3D Snap Functionality
3Dsnap, selection accuracy more efficent, Users can also customise snap symbol "Size" & "Snap" distance.  Within the : Veiwer 
Settings > Snap options > Distance

3D Viewer Worksheets
Added the ability to use company address fields on Worksheets.

Fixed large printouts with high DPI failing due to windows limitation. Reduced the auto‐DPI to rectify this.

Fixed "Job Viewer Report" print object, now displays totals for the slected columns.

Autonest
Fix implemented for autonest so it doesn't try main nesting on remants & creating remnant from DXF thus creating invalid 
sheets

Change Object(s) Properties
Fixed issue with multiple item selection when having items with insulation and double wall/materials settings that vary; was 
not obeying/reporting "Mixed Values" consistently.

Compact Database
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Fixed "compact database" wiping out hanger and insulation specifications.

Connectors
User can now multiple select connectors by using isolated selection using the CTRL key and also for block selection using the 
SHIFT key. Now gives the user the ability to edit more than one connector at a time.

Decoiler
Decoiler Output ‐ Multiple Coils/Standard widths
a) Ensure items are treated as standard if the length matches any of the standard lengths 
b) Ensure correct coil width selection for items takes correct account of whether non standard length items will be made on the 
second line
Iowa Decoiler Post ‐ Fixed items before pause lines being lost if "No Pause Lines" option is not checked.
When using Double Wall Items, the output had just adding items with the output material set to the skin material. Now adds 
items with skin size adjustments applied.

Design Line
Round up sizes logic now restricted to match button coded Hangers. Would round up to the next product listed size if the size 
isn't available.
a) Stopped hangers being filled where offset rules have been applied.
b) Fixed the filling of offsets using two bends when using non‐centreline fixbys.
Removed 'Take Off' & 'TakeOff As Cutin' menu elements when in design line mode as not required at this point.
Fixed an issue with Fitting Complex Node ‐ when the design line containing the complex node was filled, the fitting was being 
wiped.

Ductboard Bevel Connector
Ductboard Part Development amended ‐ Bevels on Non Seam Edges
Fixed seaming tool operation being applied to bevel edges that are not seam edges. Affects CID 957 specifically where bevel at 
the closed end of body. Also affected when CID 952 bevel on backwrap made in two parts, any ductboard pattern with bevel 
connector.

DXF Import
When importing DXFs, they now will be previewed with either white, black or grey background as required so all lines can be 
made visible.

Free Entry Items
Fixed the editing of Free Entry items when product listed.

Item Reports
ONorm Area of Straights ‐ Fixed calculation issue with the area print object.

Machine Tool Configuration
Fixed text fields not being updated when a row of data is copied and pasted to other rows from the Tool Details dialogue

Manual Nest
Amended segment bend end segment development so appears correct in Manual Nest part holder.

Opus
Fixed grid snapping so works with all levels of zoom.
1) Fixed incorrect deletion of Auto/Part Notes text elements when exiting Opus. 
2) Fixed alignment and rotation issues with Auto/Part Notes text.
3) Fixed slice buttons (Go & Cancel) not showing correct availabilty.
Fixed Opus drawing arcs with large radius and small angles inaccurately

Changed command in Opus for Trace "TC" as this was conflicting with the command for Trim "TR".

Oversize Breakdown
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Prevent island seam/connector expansion method that is in use duringoversize breakdown from removing pierce type holes.

PDF Import
Fixed text orientation when importing PDF underlays and when viewed in isometric.

PMCut
Low level database changes to methods that attempt to retrieve material name and gauge using material and gauge indices 
now return group name too

Post Processor
Novako Post processor ‐ NOVAKOGEN.VPL
a) Include M200 “eject‐sht.cnc" at the end of every sheet.
b) When writing seperate sheet files all sheets end with M30 When writing combined file sheets end with M01 except last sheet 
ends with M30.
Novako Post Processor ‐ NOVAKOGEN.VPL
When preparing to reposition clamps for new section start with move back to output side ‐ eject range, not all the way back to 
the output side.
Burny Post Processor ‐ BURNYGEN.VPL
Fixed M09 being used to deselect plasma marker after selection with M08, should be deselected with M07 command.
TURBOGEN.VPL ‐ Change Arc format from X,Y,I,J to X,Y,R
Procomm Post Processor ‐ PROGEN.VPL
Text printer on the machine can only print horizontal or vertical text. If text angle is rotated by user entry or manual nesting 
adjust text position to keep centre of text at same position.

Print Screen
Fixed capturing screen shots using Print Screen ‐ Double middle button click on caption was not working if the caption 
contains invalid characters for filenames.

Profiler
Cut Order
a) Ensure that cut ordering takes correct account of stitched islands when checking for outers islands that enclose later inner 
islands.
b) Ensure that cut ordering uses the correct island fragment to complete the cut when islands are not stitched
Stitches
a.) Fixed portions of islands being lost if stitches overlapped 
b.) Fixed stray leads being created when stitch at start/end is enabled and pierce point is moved away from original start/end.
Cut Order ‐ Added ability to enter the start or resume cut order number. This had been lost in the recent releases since the new 
Opus/Profiler had been re‐developed.
Fixed Slice in Profiler only applying to pattern library items. Imported and Opus drawn parts now use the Profiled/Standard 
oversize seam option.

Remnants
Fixed program crash in manual nesting if an invalid remnant is selected from Nesting tab. It now doesnt save back as an 
unreserved sheet.

Report filters
Fixed report filter 'not' duplication bug, optimised job contents for large jobs; fixed job contents section filter 'none' not 
working.

Save As Icon
Stopped the user from being prompted where to save the icon file to when using Save As Icon (defaults to the same location as 
the ITM file).

Sub Assembly
When selecting a sub item of a Sub Assembley, the attacher will select the sub items service rather than the Sub Assembley 
service.

Takeoff
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Fixed crashes in takeoff with product listed wrapped items, dimensions not being preserved and the model column not working
within the product list editor.

Worksheets
Fixed text in print outs coming out very large when using an imperial database.

Write NC
Changed output so would not add leadin or leadout when splitting islands that lie across section boundaries and only remove 
empty sections that are after last section containing cuts.

Pattern Fixes

Pattern Fixes
CID 61 (Segment Bend) ‐ Fixed the seam fold line being offset from the notch.
CID 1172 (Rectangular Angled Straight) ‐ Stopped allowing certain invalid configurations (now prompts "Geometry Is Invalid" 
warning).
CID 326, 327, 1173, 2326 (Circular Branch on Bend) ‐ Added support for full 3D branch/bend intersections; so no restriction on 
branch diameter or number of segments straddled by.
CID 835 (Rectangular Breeches 2 Way) ‐ fixed the pattern developments; missing intersections of bend and straight seams when 
attempting to expand seams or V notches.
CID 37, 185, 835 (Rectangular Drop Junction) ‐ Fixed double wall for radiused heel bends; left/right height was not being 
adjusted.
CID 330 (Rectangular Radius Offset) ‐ Seam cutbacks were not being applied correctly dependant on sides offsets.
CID 835 (Rectangular Drop Junction) ‐ Fixed incorrect top/mid develop lengths (was not accounting for points change in Z). 
Split some seam sections to show individual development lengths.
CID 906 (Oval Saddle On Straight) ‐ Fixed the display of the the branch`s curved intersected sides; was only drawing one 
central triangle for each side.
CID 951 (Ductboard 3 Way) ‐ Fixed pattern based custom oversize slice definition failing when middle height is less than 
overall height
CID 988 (Oval Branch on Rectangular) ‐ Was adding the insulation thickness to the Collar of the Skin when double wall or 
insulation applied.
CID 2965 (Circular Tee Reducer) ‐ Fixed incorrect pattern annotation when setting the body diameter; from "Auto" to a value 
different from the top diameter.
CID 394 (Circular Elbow) ‐ One part development was using the minimum of both extensions as inner radius, resulting in 
extensions to be developed at double actual lengths.
CID 830 (Straight 1‐20 Branches) ‐ Fixed when pipe 2 parts, the parts had connector notches taken out 

along one seam.
CID 1115 (Oval Conical Tee Cross with Reducer) ‐ Fixed Double Wall adjusting the right extension dimension.

CID 836 (Radius Double Offset) ‐ Front/back holes were developed incorrectly if offset "central".
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2.38.221 18MAP Software Version: Version LOK Code : Release Date : 08/04/2010

Application Fixes

3D Viewer
Fixed a crash in PM2000 if Job Contents is the default viewer but Quick Takeoff is used to enter an item in the 3D Viewer.

3D Viewer Worksheets
Fixed Job Viewer Report print object to display totals for columns selected to do so.

Autonesting
Fixed the user having to select the Autonest method before actually selection the Tick box option fromt he Autonest Options 
dialogue prior to nesting.

Carry Over Insulation
Stopped carrying over insulation if carry over insulation is off, but carry over double wall is on and double wall isn't being 
used.

DXF Export
Fixed unsafe use of white line colour in the DXF layer table thats created when exporting the DXF files. AutoCAD had problems 
reading certain DXFs when attempting to import.

DXF Import
Included DXF capability for importing DXFs with 2D polylines that have a non standard extrusion direction.
Fixed default Tool which is assigned if Tool tag does not exactly match existing Tool in the database when using the Tool / Layer 
mapping method from the Profile Database. Changed so it matches the most similar tag to avoid no tool being selected for that 
island.

Multiple Item Properties
Fixed multiple item property (with dims enabed) showing adjusted (skin) size for double wall if entering by skin size, not main 
body. When user clicked ok we then stored the skin size as the main body size and increased the size!
Stopped forcing the redevelopment of items when using multiple items properties, if user doesn't change the dimensions.

Quick Takeoff
Fixed issue with Add Couplings option when in Quick Takeoff using Services mode, couplings are now automatically entered.
Fixed Quick Takeoff warning the user there were no assigned tables for Fabrication and Installation even though tables had 
been assigned.

Stiffeners
Fix introduced to enable stiffening at the end positions regardless of whether set to be stiffened centrally. Had not being getting 
these stiffeners previously if central had external assigned.

Pattern Fixes

Pattern Fixes
CID 948 (Ductboard Straight) ‐ Fixed material compensation for when creating a hole in a UxI development.

17 58ofPage



Software Changes Document: CAM‐Duct

2.38.217 18MAP Software Version: Version LOK Code : Release Date : 02/03/2010

Application Fixes

DWG Import
Fixed imported DWG files missing some types of text when imported as an underlay inside the 3D Viewer.

Insulation Specifications
Fixed insulation specs not always adjusting the skin size properly.

Opus
Fixed issue with +/‐ entry via the numpad keys. There had been problems when having a command active and then attempting 
to use the numpad +/‐ keys to select next point.

PDF Import
Some PDF writers (CutePDF in particular) create text as filled polygons which had been ignored when importing the PDF 
underlay within the 3D Viewer.

Post Processor
Gasparini Post
Fixed NC start position passed to IslandStart method used by Gasparini post.  NULL Tool sections at start of rip cut island made 
rip cut diagonal with this post.
ARTGEN2 Post Processor 
Fixed broken NC when using Hi‐Def plasmas. Tool was not being selected due to changes previously made for Ductboard 
machine as this post support both types.
Burny Post Processor 
Special Features ‐ Fixed couple of typos in TOOLBASE,TXT that affect Burny posts
1) BURNYGEN.VPL FT*26=Omit Program Number was wrongly displayed as unused FT*26=Output Actual Feed Rate 
2) BURNYASGEN.VPL FT*84=Island Area Slowdown was empty line
Mach3 Post Processor ‐ MACH3GEN.VPL
Machine does not support relative motion G91 at start of program. Change made so that it forces absolute motion in the NC 
output  in case machine setup is set to use relative motion
All Post Processors
1) Fixed program error when checking for equality of two strings if the second string is empty.
2) Change post processor string class to allocate its initial buffer dynamically.
3) Also implemented fix when writing combined files if the length of names of the files to be combined exceeds fixed buffer size 
or too many files to be combined

Screen Capture
Fixed capturing screen shots holding down Print Screen key and then double clicking middle mouse button to prompt the save 
of the active window.

Splitters
Splitter holes are now set to zero if the inset value >= half the splitter length to stop resulting in negative spacing.

Takeoff Screen
Fixed the OpenGL View number 3 in takeoff mode to match non‐OpenGL view 3.

Write NC
Seaming
Implemented change so will not reapply main leadin/leadout at start/end of stitches when writing NC.
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Pattern Fixes

Pattern Fixes
CID 132, 133, 134, 136 (Various flat oval) ‐ Fixed pattern developments.

CID 110, 112 (Flat Oval ‐ Hard/Easy Offsets) ‐ Restored pattern developments.

19 58ofPage



Software Changes Document: CAM‐Duct

2.38.214 18MAP Software Version: Version LOK Code : Release Date : 03/02/2010

New Features

D6 Essi Post Processor ‐ D6ESIGEN.VPL
When writing NC files in combined mode, added a final empty sheet at the end of the sequence to emulate 

Vulcan "Autoload" NC.

Application Fixes

Airturn Calculations
Changed the number of banks calculations to check Minimum Length against Duct Depth not Vane Length, to agree with DW 
specifications.

Burny Area Slowdown Post ‐ BURNYASGEN.VPL
Fixed Height control wrongly disabled for central cuts with air plasma tool.

CRE Post Processor ‐ CREGEN.VPL
Removed ATTACCO (leadin) before all central cuts from NC, was causing an error on the CRE controller.

Part Labels
Fixed inconsistencies in the way part straight labels with bending info are rotated to best fit ‐ parts with very small differences 
were being rotated differently.

PPI Post Processor ‐ PPIGEN.VPL
1. Made block numbers at the start of NC lines optional 
2. Replace parentheses inside comments with spaces, PPI controller does not allow nested parentheses.

Pattern Fixes

CID 14 (Rectangular Breeches)
Removed the incorrect display of left & right height dimensions.
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2.38.212 18MAP Software Version: Version LOK Code : Release Date : 25/01/2010

Application Fixes

3D Viewer
Fixed bend disappearing if stretched using CTRL held down (for adding straight lengths). Only occurs when pattern cache is 
disabled from UEDITMAP.

Decoiler Output
Engel USA Decolier
Change made to Pass Coil Width used by item in its decoiler calculations rather than default sheet size width.

Invalid Dimensions
Fixed a problem with internal dimensions not working (wrong/bad dims) if they relied on dependant (calculated) dimensions.

MAP.ini
Fixed paths being made absolute if using "../" reference to move back a directory.

Memory leak
Fixed a memory leak in the valve pattern (CID 868).

PDF Import
Removed the justification from text styles and also fixed PDF underlays displaying the text in the wrong positions.

Post Processor
CRE Post Processor 
1.) Fixed duplicate lines when moving to Rip Cut, caused by rounding error
2.) Added Use Machine Setup rail and beam offsets when writing NC,  
3.) Fix expansion of subroutines that have no tool when viewing NC.
CRE Post Processor
Remove "ATTACO" (leadin) line from before ripcut.

Profiler Slice Option
Fixed Slice option in Profiler which had been only applying oversize seams to parts from pattern libraries. Now includes 
imported DXFs and Opus drawn parts where standard oversize seam is used to perform slice.

Takeoff Colours
Colours = None now only displays for the dimension background colour which was previously shown in the viewers.
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2.38.210 18MAP Software Version: Version LOK Code : Release Date : 12/01/2010

New Features

Batch Processing
Added single panel recut requests (.SPR) to batch processing. Also included new wizard task 'recut request' that adds user 
interface to this and BIR's. Moved Batch Process icon in wizard to the 'Other' tab.

Connectors
Improved Slit Hole options by allowing all options (Length, Width, Inset, Centres, Outer) from Pattern Options setup to now be 
isolated per connector. Can now define settings in the Connector database so that each connector can define its own slit hole 
settings or default to the original settings in Pattern Options.

Database ID
Now allow Database ID to be displayed in Folders view, will not display for Product Lists which have multiple entries.

Decoiler Output ‐ Connector Fold
Add new decoiler option to allow control of folding based on connector type. Initially added for Autofold decoiler so that 
folding can be disabled when TDC connectors are used.

Design Line
Pressure Drop Rules: during 3D Fill of design line, if a node has a single item, and that item has a non auto rule, apply the rule 
to the item. Allows several items using same pattern to use different rules to look up resistance tables.

Dialog
Now allow messages dialogs with expandable details to resize.

Ductboard
Moved Ductboard tool options from Pattern Database > Ductboard Options to individual machine settings.

DWG/DWF/PDF Imports
Revamped DWG/DWF/PDF imports to use common code and produce Shells for 3D imports (allows separate 
selection/isolation).

DXF Export
Added Edit Layer Map dialog so that user can configure the name, colour and linestyle of DXF layers that the Display Only, 
Cutting and Marking sections go to.

HASP Dongle Utilities
Added Fanuc O‐M Post Processor (FANUCOMGEN.VPL)

Added Gasparini Post Processor (GASPARINI.VPL)

Hole Stitching
Added the ability to stitch all holes using the global option located at Pattern Database > Pattern Options > Hole Stitching. Also 
includes stitching on newly created holes added via the Add Hole button..
Does not add the stitching if exported to DXF output file. Stitches appear as gaps in the part.

IFC Export
Added colours to the IFC (step) export.

Item Scripting
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Added print object and scripting access to Item Decoiler Beading so can view whether set to Yes or No.

MAPUSER
New entry added "Edit Sections", which only allows editing of the Sections Database without access to Service Database or Full 
Database.

PDF Importing
PDFs now maintain their original line weights when imported into the viewer.

Post Processor
Gasparini Post Processor
Added TI19 "Voltage" option to allow plasma arc voltage to be controlled by a user setting. Was previously preset to 120V.
RapidGen Post Processor
Fixed torch raising to a default height of 60m just before rip cut completed.
AXYZ Post Processor
Added a new special feature "Set Height Zero at Table Top" to support new type controllers
Burny Download Program
Add option to control whether leading zeros sent by controller should be stripped from the filename opened at the PC.
RapidGen Post Processor
Added special feature "Relative Arc Centres"
ATTGEN Post For Spiro ‐ Added support for new temperature (plate/pierce height) sensor.
RAPIDGEN Post Processor
Add Special Features "Block Numbers" and "Mach3 Codes" to allow post to output required code.

Profiles
New option added to EDITMAP and CAD/CAM Message Prompts for Switch Profiles. Allows the user to control whether a prompt
appears when the software attempts to revert to the profile the drawing was completed in.

Rip Cut
Added option to always perform Rip Cut regardless of minimum size value entered. New option added to File > Setup > Installed 
Machines > Machine Setup > Rip Cut Setup.

Services
Change applied to allow renamed IEZ's to import without prompting any error.

Takeoff
Added the ability to toggle between Metric and Imperial using the F11 key on the pattern takeoff view.

Textures
Added Textures folder to MAP.INI. Revamped MAP.INI processing ‐ removed support for importing ancient MAP.CFG.

Write NC
Added support for Posts such as Gasparini which write subroutines island by island instead of part by part.

New Patterns\Enhancements

CID 16, 24, 345 (Circular Branch on Flat)
Introduced options to notch ends of hole developments. When enabled on the pattern, it uses the Pattern Database > Pattern 
Options > Notches > Hole values.

CID 66 (Circular Shoe on Straight)
Enabled castling of the branch hole on pipe. Enabled via the Item tab of the takeoff screen which uses the Pattern Options 
Castle values.
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New Patterns
CID 1150 (Splitter Damper Blade)
CID 1152 (Structural Steel Arch)
CID 1153‐1155 (Ductboard Rectangular Reducers)
CID 1156 (Ceiling Panel ‐ Including developments for manufacturing)
CID 1157 (Stairs)
CID 1159 (Partial Grille)
CID 1177 (Conical Branch)
CID 1180 (Linear Radius Diffuser)
CID 4522 (Rectangular Coupler) ‐ Allows rectangular items to be coupled together in the same way as Round and Oval, based 
on connectivity matching.

Pattern Enhancements
CID 7 (Rectangular Shoe) ‐ Now supports "Add Hole", skin will be applied to hole if "Double Wall" enabled.
CID 8, 29 (Square to Round) ‐ New option added to the Options list of the Square to Round called "V Notch Rectangular 
Extension". When Notch for Connector Split from Pattern Options > Notches is set to None, this option can be used to seperate 
the Rectangular Connector extension on the Seam.
CID 51, 71, 162, 2051, 2071, 3051 (Circular Reducer) ‐ Diameter dimensions renamed to "Diameter In" & "Diameter Out".
CID 68, 107, 111 (Round Offset, Oval Bend, Oval Offset) ‐ New option added "Automatic nest break if oversize".
CID 78 (Register) ‐ Added separate dimensions for top and bottom hole types.
CID 115, 117, 887, 906 (Oval Saddle On Straight) ‐ Now supports double wall and Auto extensions (increased pipe`s default 
length so the DW branch will fit).
CID 8 & 29, 382, 893 (Square to Round, Rectangular Grille Box, Angled Grille Box)) ‐ Now support "Add Hole".
CID 501, 502, 509, 533 & 914 (Damper Patterns) ‐ New control type added: Option #2 "Knob".
CID 1102 (Toilet) ‐ New options added "Square" or "No Box" for cistern and options to set downward output pipe.
CID 1115 & 1116 (Oval Tap(s) on Straight) ‐ Added Connector #5 where the body meets the reducer. Added the ability to change 
to Round branches which also triggers the connector type; Branch Depth field is required to be set to Round or else the pattern 
keeps the Oval connector types.
CID 1115 (Oval Conical Tee Cross with Reducer) ‐ Skin Calculations were adjusting the right extension dimension when "Auto", 
resulting in a very long reducer skin extension; fixed.
CID 1133 (Damper Box) ‐ Added dimension field for Damper Inset: Central or a value available.
CID 149, 1049 (Wall Sleeve) ‐ Now enabled for use if the dongled option Standard Parts is enabled.
CID 166 (Rectangular Canvas Connection) ‐ New options to define the 2D line detail spacing, enables input of either quantity or 
spacing.
CID 2, 27, 253, 342, 440, 441 (Rectangular Taper) ‐ Allow holes to be rotated.
CID 2326 (Stab‐In on Round Elbow) ‐ Now allows different top diameter from bottom diameter; branch is specified using X/Y 
offsets.
CID 2881 (Radius Branch) ‐ Now reports branch centre line length in the graphical view and included option for Branch 
Centreline Length with Collar Yes or No.
CID 2938 (Wye + Bend) ‐ Added option to specify branch insets to the ends of the branch bends extension.
CID 1114, 2821, 2899, 2326, 2044, 2938 (Urinal, Reducing Radius Tee, Straight + Bend, Stab‐In on Round Elbow, Straight + 
Branch, Wye + Bend) ‐ Options added to define inlet & outlet numbers.
CID 2965 (Round Tee with Reducers) ‐ Now supports centreline input.
CID 838 (Hanger) :
‐New type added "Double Profile Bearer".
‐Added Oval to the Profile when Type Profile Bearer, Stirrup (Half Oval) and Split Ring (Full Oval) are selected.
‐Added area of influence circles for Z and Flat Strap hanger types.
‐New options added to draw arrow, when configured as either "Wrap Round" or "Clipped Flat Strap".
CID 857 (Pressed Bend + Branch) ‐ New option to set the branch as rectangular or oval.
CID 868 (Valve) ‐ New options to define inlet & outlet numbers.
CID 916 (Waste Trap) ‐ Added OpenGL annotation, additional dimension for C2 (different inner diameter whilst not affecting 
pipe diameter).
CID 985 (Beam Strut) ‐ Added CAD nodes and now supports stretching.
CID 996 (Terminal) ‐ Added 2 new draw types: Lines and Square, set via option #1 "Type". Lines draws a series of parallel lines, 
Square draws rectangular hatch pattern, the spacing is taken from option #8.
CID 519, 533, 556 (Rectangular Straight, Rectangular Damper, Circular Coupler) ‐ Added new Option: Draw Type "Cross Talk 
Attenuator".
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Application Fixes

3D Viewer
Fixed importing of underlays (PDF/DWF/DWG), all layers in the imported underlay were coming in as white and staying as 
white even if the user selected a different colour in the layers dialogue.
Resolved problem with selection if UCS is enabled.

Fixed monochrome underlays (rasters) to display correctly. The background colour now to be transparent.

CID 835 (Drop Cheek Y Breeches)
Fixed seam junction notches, they now expanded correctly.

CID 838 (Hanger)
When "Cutting In" Product Listed Hangers on Pipework with outer Insulation enabled, the Hanger was not taking into account 
the Pipe OD for upsizing to the correct Hanger.

Colours
Fixed issue with material colour defaulting to colour of insulation if insulation removed from the item at a later stage. Occured 
when previewing or printing Worksheets and Labels.

Coupler logic
Changed coupler logic to load Rectangular/Oval couplers when the width and depth are equal, was only loading round.

Design Line
Fixed an issue with Service Terminal Styles not appearing in the Terminal Styles drop down (when button type is set to 
Terminal). Issue occurs when accessing button properties through Edit Service Template dialog.
Pressure Drop Configuration Tables
1. Ensure dimensions names are not repeated if the configuration contains a CID value more than once.
2. Ensure all dimension names are unique.
Bridge Pattern change which now has the option to draw bounding box face around area of fitting in place of line detail alone.
Added logic to allow unfilled complex nodes to be filled by a bridging pattern if there is on available. Other fixes introduced for 
how complex nodes behave between sessons.
Changes made to complex node filling. Now resolved issue with straights no longer overlapping complex fittings.

Dropper Lines
Fixed an issue with filling dropper lines which occurs when multiple mappings are attempted for the expansion. The various 
mappings having different effective offsets.

DXF Export
Fixed so that DXF no longer includes leads on parts exported.

DXF Importing
Set the preview background colour to white, black or grey to ensure visibility of lines.

EDITMAP
Fixed absolute paths being converted to relative paths on Save.

IFCs
Fixed import of IFC file when no colour assigned (for example white on white background). When moving, it will now produce 
grey lines for visibility.

Import Services
Selecting the "Browse" button was not updating the list of services to show the ones read from the newly selected file.
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Insulation Specification
Resolved inconsistencies when changing insulation specs.

Insulation Specs
Allow item insulation spec assignment for product listed items in quick takeoff.

Item Labels
Fixed break/roll decimal places on label graphic for metric users to show 0 instead of 2.

Item Reports
Fixed colours of the header sections also affecting body of the report.

OPUS
Added initial Underlay Object support to OPUS (raster images). Also added support for drawing pierce definitions plus basic 
adding/modifying operations.
Fix instroduced to stop RepairPart removing all pierces when the utility is used.
Fixed problem when editing a part created in Opus. When accessing the Opus part from the Job Contents > Items tab, double 
clicking was causing the software to crash.
Improved action for when dragging the minor axis of an ellipse part.

Post Processor
EMACHATC Post Processor
‐ Changed tool selection code from G55 to G54P00# where # isthe  tool Post value 
‐ Now also issues tool selection commands before traverses
EAMCE10GEN.VPL Emach Knife Post
Fixed traverses being omitted in tool by tool mode due to a typo.

Printing
Fixed problems with printing underlays that contained rastor images. Print was producing grey rectangles.

Profiler
Fixed issue with Part repair which was incorrectly adding leadin/leadouts to islands containing just a pierce.

Services
Fixed the dialogue that appears when adding a new item to a service button. Dialogue now provides an even 50/50 split by 
default for the folder structure and item files.

Sub Assembly
Fixed potential OpenGL leaks closing down the sub assembly editor.

Product listed sub assemblies now uses takeoff to allow user to configure product definitions of the assembly.

Fixed sub assembly form not closing properly if in orbit command.

Terminal Styles
Fixed an issue with Service Terminal Styles not appearing in the drop down box when the Button Fitting Type is of type Terminal. 
Issue occured when accessing Button Properties from the Edit Services Template dialogue.

Write NC
Prevented crash for when modified cut order has more steps involved than the initial cut order.

Pattern Fixes
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CID 32, 150 (Straight with Branch(es))
Added the options to control connector fold notch at C2 end when set to Use Vee Notch.

CID 61 (Segment Bend)
Fixed seam fold line being offset from notch.

Pattern Fixes
CID 6 (Rectangular Offset) ‐ Resolved issues with incorrectly angled holes if the item's offset height was a negative value, 
developed hole positions were positioned incorrectly.
CID 28 (Square to Round ‐ Angled) ‐ Amended the length dimension annotation so it displays through the centreline of the 
isometric view.
CID 31, 19, 21, 26, 382, 956 (Rectangular Grille Box) ‐ Disabled options for number of parts and notch angle for lids. Ensured 
dimensions/options were made consistent throughout all patterns. Enabled multiple hole types (Round, Oval, Rectangular) and 
the ability to develop collars for the holes.
CID 33 (Straight + Shoes) ‐ Resolved issue with pattern's connector 2 direction being inverted, this resulted in the item 
attaching incorrectly.
CID 73, 99, 100, 863, 869 (Circular Breeches) ‐ Fixed CAD nodes being removed when double wall enabled.
CID 127 (Plate with Holes) ‐ Fixed hole positioning not allowing the hole to be within 25mm of the plate edge.
CID 134 (Rectangular to Oval) ‐ Fixed annotation line so displays correct length.
CID 385, 842, 843 (Oval Straight with Branches) ‐ Fixed dimensions being reported after recently added reducer dimensions on 
pattern 839.
CID 802 (Rectangular End Cap) ‐ Resolved an issue with added holes when configured as Oval, the connectors were being 
applied incorrectly.
CID 835 (Breeches 2 Way) ‐ Resolved  inner arcs developing incorrectly.
CID 988 (Flat Oval Branch) ‐ Double wall now includes the branches extension.
CID 1104, 1117, 1118 (Branch on Oval) ‐ Resolved issue with incorrect positioning of "Fold Lines" on developments.
CID 1110 (Auxiliary Box) ‐ Fixed not adding added items correctly.
CID 2148 (Multi Tap Mixed Branches) ‐ Fixed branch insets by adding extra dimension feilds. Annotation also adjusted to 
match relevant dimension references including a new center line field.
CID 2326 (Stab‐In on Round Elbow) ‐ Fixed occasions when the top diameter was the same as the bottom diameter. Fixed the 
branch was not drawning correctly due to not being fully intersected with bend (branch outer end being partially within the 
bend).
CID 2882, 2883, 2885 (Swept Branches) ‐ Branch extension now draws centreline.
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2.38.200 17MAP Software Version: Version LOK Code : Release Date : 12/01/2010

New Features

Post Processor
NUM Post Processor ‐ NUMGEN.VPL
Added support for marking using MT4 marker tool.
Recent plasma machines mark with the plasma tool at low power (MT1). Older machines had a separate scribe/powder marker 
(MT4) requiring tool offsets to compensate.

Post Processors
Add new Post Processor PPIGEN.VPL

Write NC
Added a new method to main program; enabling posts to identify central cuts.

Application Fixes

Autonesting
Fixed autonesting when slicing parts to fit the maximum sheet size. It had been producing parts that won't nest since autonest 
accuracy enhanced.

Burny Area Slowdown Post (BURNYASGEN)
Use contour extents to calcluate area for slowdown if cut is central.

Opus
Slit command now changed so it operates the same as it did in older versions of Opus and not detecting the slit as a central 
island cut.
Fixed issue with Intersection and Tangent snaps not functioning unless Start/Middle/Nearest Quad Snaps also activated.

Shortcut Keys
CTRL+D now selects the dimension field for product listed items when Takeoff Product Lists by Dimension is enabled from the 
Main Database > Configuration dialogue.

Text Styles
Corrected the size of the dimension arrow head shown in the Text Style preview dialogue.
Fixed crash when changing a text style's "End Type Size". A value now needs to be specified between 1‐8. Initially it would allow 
a value of zero but would crash when attempting to re‐draw.
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2.38.197 17MAP Software Version: Version LOK Code : Release Date : 07/12/2009

New Features

Folders.ini
Folders.ini now loads/saves to install path by default (still uses the working directory 'Start‐In' path, if it exists).

Post Processor
Lenze Post Processor ‐ LENZEGEN.VPL
Added feedrate at end of arc lines, including standard arc slow down logic.

Step Down Connectors
Added support to draw Step Down Connector types in Takeoff views and the 3D Viewer.

Application Fixes

Autonesting
Fixed Autonesting that had been missing parts when using the pre‐nest option and if sheet margins were specified. Pre‐nest had 
been creating nests that were too big to fit on the sheet.

Design Line
Sized Nodes when placed in the model were losing there size. Fixed so that sizes are filled correctly when generating the 3D.

Dimension Styles
Fixed the dimensions in the viewer not using the correct precision configured from the style dialgue. Dimension text was using 
the original style it was created in for its precision settings rather than theselected style.

Manual Nesting
Fixed manual nests to ignore lead‐ins if specified a value from the General Nesting dialogue from the Main Database > Ignore 
Lead In. (Values less than the value entered would be ignored).

PDF Importing
Fixed an  issue with imported PDFs not adding its own style into the database when the style had a bold or italic type. A '#' was 
represented in the database causing the font not to display or revert to the default style.
Fixed issue with text not appearing until a REGEN command is completed.
Fixed problem with justification of text when importing PDFs as an underlay. Text styles created by PDFs no longer have a 
rectangular border displayed.

Post Processor
Emach Post Processor ‐ EMACHGEN.VPL
Added special feature "Use Alternate Tool Codes". If this option is enabled from Installed Machines > Setup > Special Features, 
NC incorporates tool on as M82 not M61, tool off is M83 not M62, and M82 is only included once at the start of each cut.
Amada Post Processor P69GEN.VPL
1) Added special feature "Etch with Cut Command" available from the Machine Editor > Special Features dialogue. This now 
fixes the clamp offsets if the etch tool is used first.
2.) Place M100 focus command after the M102 material type command.

Profiler
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Fixed pierce modifications being lost when in Manual Nesting. This occured when switching between edit mode and lead move
mode a few times.

Saving with Compression
Fixed errors when saving jobs or items when they are opened in read only and compression is turned on from the User 
Interface.

Scripting
Fixed item.qty scripting variable which was being treated as a string, not a value (calculations when using this had been 
failing).

Shortcut Keys
Fixed shortcut key for CTRL+D so that highlights the Dimensions field in Quick Takeoff (non‐CAD mode).

Simplify Islands
If Simplify Islands was enabled, the NC could become broken for some parts if the Tolerance setting was set towards the High 
end of the range. Was caused by Precision parameter being passed to simplify logic being 100 times larger than expected.

Styles
User is now able to change attributes on Default styles.

Sub Assembly
Items within Sub Assemblies were having their Qty incremented when collecting identical items for Job 
Contents/Reporting/Cam.

Swap Out
Implemented change for swapping out non‐product listed items that was breaking takeoff of simple non‐conditioned items. 
There had previously been problems editing these items in Quick Takeoff.

Takeoff Views
Takeoff views now represent whether Airturns, Splitters etc are displayed or not. Previously the view was not updated if 
disabling these options.

Template Items
Introduced service button conditions for template items (non‐product listed) and also the ability to swap out items based on 
the initial carry over value.

Pattern Fixes

CID 1101 (Bridging/Exception Pattern)
Resolved issue with the Bridging Pattern causing the application to crash when manually adding into a drawing via takeoff.

CID 150 (Rectangular Branch on Straight)
Fixed problem when developing this part with the 2 Parts = Yes/No option enabled. Added holes were being developed twice in 
certain instances.

CID 2051 (Pipework Circular Reducer)
Resolved development of insulation when enabled and with the option for Length Includes Extensions set to Yes. The insulation 
length was previously greater than the body of the reducer.

CID 2965 (Round Tee with Reducers)
1.Fixed insulation prompting an unecessary invalid dims warning.
2. Fixed Auto collars (caused extreamly large collar value).
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CID 4, 17 (Radius, Reducing Bend)
Fixed Double Wall when inner radius at zero or less than skin size.
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2.38.186 17MAP Software Version: Version LOK Code : Release Date : 03/11/2009

New Features

Scripting
Added item.catalogue to scripting references. Will return a 1 if Catalogued and 0 if a Template item.

New Patterns\Enhancements

CID 2881, 2882, 2883, 2885 (Radius Branches)
Radius Branch patterns now allow stretching on end nodes which in turn increases the collar lengths; 2881 draws center line 
for branch collar.

CID 2965 (Round Tee with Reducers)
The Body Diameter now sets its OD from C2 end rather than the Branch Connector end.

Application Fixes

Ductboard
Fixed program crash when the user attempted to change machine or tool options and then re‐wrote NC data.

DXF Importing
Fixed problems with missing text and text rotation when importing DXFs.

Insulation Specification
Fixed crash when having Insulation Spec set to Off and attempting to save job.

Item Folders
Fixed corrupt patterns causing the crash of item folders during fill. Will now report non‐fatal errors on selection.

Notches
Fixed unwanted notching at split corners on circular pattern developments. Software applying notches even when the option 
for Notch Round Corners > Conn/Seam was not checked from Pattern Switches.

Printing
Fixed crashing when printing Labels. Optimized the compiler to ensure does not crash when sending the label to the printer.

Services
Fixed Cut In method from Services takeoff not applying carry over of item number to the new straight. This happened when the 
straight is split into 2 pieces.

Services Database
Fixed being able to sort by columns within the Sections dialogue of the Services database.
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Text Annotation
Level text and Size text now use the precision values defined from the CAD Settings dialogue > Main Database > CAD Settings, as 
opposed to using the Configuration settings for its number of decimal places. This effected BODTOD and Duct Size annotation.

Trackit
Fixed program crash in Trackit if there aren't any Database exports or Reports in the MIS report folder.

Pattern Fixes

CID 32 (Straight & Branches)
Fixed crash if more than one hole had been added when opening in Release 2.38.179.

CID 580 (Round Access Panel)
Round Access panel type changed from Flat Oval to Round. This now becomes a successful 3D Fill when using Design Line.
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2.38.181 17MAP Software Version: Version LOK Code : Release Date : 20/10/2009

Application Fixes

Insulation
Fixed locked insulation and double wall settings being over‐ridden by insulation carry over if enabled.

PDF Import
Fixed page border orientation when importing PDF files into the underlay.

PDF Importing now ignores closed polygon paths that are solid filled and not stroked (filled but with no border).

Fixed importing a schematic (PDF/DWF/DWG etc) to create missing text styles.

Post Processor
EMACH ATC Post Processor
Enabled post processor to output NC in necessary format supplied in original specification.

Scripting
Fixed IF and ELSEIF statements reporting errors.

Out of Memory error fixed when processing some scripts.

Pattern Fixes

CID 18 (Side Branch)
Resolved issue with incorrect placement of connectors on holes added to item

CID 32 (Straight & Branches)
Fixed Connector 2 end to include marker notches for the folds. This pattern previously had the hole number wrong for the first 
hole and resulted in a V Notch depth and angle of 0 for the Connector 2 end marker notches.
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2.38.179 17MAP Software Version: Version LOK Code : Release Date : 13/10/2009

New Features

Profiler
Re‐implemented multiple island selection capabilities in Profiler for the TOOLUSE command.

Rectangular Coupling
Added Rectangular Coupling CID 4522, allows rectangular items to be coupled together in the same way as Round and Oval, 
based on connectivity matching.

Application Fixes

3D Viewer
Fixed issue when deleting objects in a drag/stretch mode.

Profiler
Fixed issue with Cut Order by re‐implementing force part check logic when using the CUTORDER or TOOLUSE commands.

Quick Takeoff
Fixed automatic takeoff of hangers when using the Add Hangers option.

Pattern Fixes

CID 3, 7 (Rect. Bend & Rect. Branch)
Fixed invalid dims warning if enabling double wall/insulation when extensions 0 or less than the skin size.
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2.38.177 17MAP Software Version: Version LOK Code : Release Date : 29/09/2009

New Features

Scripting
1. Add "WEIGHTLOCK" to scripting (item.weightlock = TRUE or FALSE)
2. Allow scripting to write to the "WEIGHT" field item.weight = 123.456

Application Fixes

Opus
Fixed typing coordinates into opus when using the line tool, was ignoring the coordinate input and snapping to the mouse 
cursor.

Sub Assemblies
Fixed the carry over of dimensions for product listed sub assemblies not working.
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2.38.174 17MAP Software Version: Version LOK Code : Release Date : 17/09/2009

New Features

3D Viewer
Improved speed of underlay import for BMP/PDF file types.

Dampers
New Draw Type added "Simple", which just draws the the shaft, could be used to show electrodes on fused welded pipework.
Fixed problem creating a "new" damper that was setting the Shaft Length to ‐1001.

Design Line
Introduced the ability to display the units of the entries when adding fields for Design Line Restrictions in Constraints to 
distinguish between Total Pressure Drop and Pressure Drop per length
The following patterns now support the filling of Complex nodes, CID 10 (2 Way Tee), 18 (Side Branch), 30 (Mitred Offset), 31 
(Grille Box Cross),1120 (Ductboard ‐ Multi Way), 1121 (Drop Cheek Breeches).
Added the ability to edit prompted lengths in the line editor dialog.
Constraints now have the option to sort in a user defined order, new buttons have been added to the Service Database interface
to move individual entries up or down in the list. The "Design Line Editor" will display the constraints in the user defined order.

IMPORTRUN Command
Allow ImportRun command to ignore SubType from file, if blank.

Item Reports
Added the ability to access Job Custom Data inside of Item Reports

Item Scripting
Added access to Item Centre Line Length via item.length and connector size through item.connector[].width/depth

OPUS
Angle text entry now default to relative (ie. enclosed) unless use @ prefix.
Added initial Underlay Object support to OPUS (raster images).  Added support for drawing pierce definitions plus basic 
adding/modifying operations (OPUS).
Now only allows importing of catalogued items

Added toolbars for tools, notches & dimensions.  Added base‐point relative location of some points in the notch commands.
Removed "Relative To" label (unnecessary).  Fixed a couple of bugs with EXTEND command.  Cancelling offset step (i.e. on 
Cut‐Outs) no longer cancels entire command if base‐point has been set.

Added ability to reduce the automatic annotation 'noise' by adding the "Annotation Style" setting.  Added buttons in Profiler to 
do 'quick' versions of SIMPLIFY on a Part/Islands by using the current parameters (i.e. no Dialog).  Added offset step to CIRCLE, 
ELLIPSE and RECTANGLE.
Changes made so that options showing 'DXF Out' now show 'DXF Export'.  OPUS now also hs a report dialogue for when you use 
the Repair option.

Post Processor
GoMech Post Processor ‐ Changes made to the Router tool start and stop codes used by the controller.
D.Electron Post Processor ‐ DELECTRONGEN.VPL)
Added post to the Hasp Dongle Utilities option list.
CR Post Processor ‐ CREGEN.VPL change to replace material name and sheet size with fixed values so that sheets are not 
reordered by the CR controller.
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Print Objects
Added new Print Objects, "Duct End Size 4" & "Item Connector 4" to report out on the Item's end 4 size and connector name 
respectively

REJ File Type
Added new File Type. REJ (Remote Entry Job) file types now supported in CAM‐Duct for processing jobs created in the new 
Remote Entry Software.

SysScrReport
SYSSCRREPORT command will now default to creating a CSV file instead of an MDB as Microsoft Access JET support is not 
available in 64 bit windows. The user can still choose MDB if desired, it's an option in the file types.

TrimbleExport
Added "TrimbleExport" command to CAM, Constructicad etc.

Write NC
Added support for Posts which writes subroutines island by island instead of part by part.

New Patterns\Enhancements

CID 1111 (Tee Coupling)
New option added to configure as a Cross, i.e. draws double tap.

New option to add a handle for the top branch.

CID 1111, 57, 840 (Tee Coupling , A P Saddle)
Tee Coupling: added option for handle on top branch.
A P Saddle: added branch`s collar length dim, and option to develop it; fixed bug: attacher didn`t show on C2.

CID 1124, 1125 (Twin Bends)
Modified both Twin Bend patterns, each individual bend now has its own bottom extension dimension entry.

CID 1127 (Reducing Bend & SqrToRnd)
Added option to not replace join connector sides with join seam.

CID 1128 (Twin Taper)
Added a third seam to the pattern so that seam 2 replaces the connector at C1 end and seam 3 replaces connector at C2 end

CID 114 (Oval Branch on Straight)
Increased MAKEPAT branch lengths to stop invalid dims when double wall enabled.

CID 1146, 1147 (Rectangular Hood)
New patterns added 1146 (Rectangular Double Hood) & 1147 (Rectangular Single Hood)

CID 1148 (Rectangular Sarejevo Taper)
New pattern Sarajevo Taper  which allows the input of extensions of different length on each side of top and bottom panels.

CID 115 (Oval Saddle)
Now supports double wall.

CID 1151 (Socket Reducer)
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New pipework reducer pattern.

CID 123 (Oval to Round)
Now supports double wall.

CID 140, 377 (Oval Crosses)
Now supports double wall.

CID 24 (Shoe on Flat)
Added option to not display internal lines.

CID 2523 (Pipework Bend)
Added option for center line length to include extensions.

CID 2938 (Wye + Bend)
Added option to specify branch heights to ends of branch + bend.
Added option to specify branch insets to ends of branch + bend + extension.

CID 3071, 3386 (electrical versions of CID 71 Reducer & CID 2386 Offset Reducer)
Electrical conduit: reducer and offset reducer patterns.

CID 311, 379, 886 (Saddle Tee T2, Combineed Saddle Cross, Saddle no Pipe)
Now support double wall.

CID 328 (Rectangular Trouser piece)
Fixed the Bottom Cheek bending information, was inverted for the developments.

CID 33 (Straight + Shoes)
New options added to position the branch insets from "C1 to branch Centre Line" and from "C2 to branch Heel".

CID 382 (Grille Box Variable Hole)
Added new option to switch the hole size dimensions if necessary, according to holes positioning.

CID 3873 (Electrical Flex)
New pattern based on Pipe Flex for Electrical Flex.

CID 42 (Circular Branch on Straight)
Removed the minimum limit for pipe diameters.

CID 57 (A P Saddle)
Added branch collar length dimension and collar development option.

CID 57, 840 (Circular Box on Straight)
Added branch`s collar length dim, and option to develop it; fixed bug: attacher didn`t show on C2.

CID 62 (Saddle Tee)
Now supports double wall.

From centerline was affecting branch 1 offset instead of length.

Added missing annotation.

CID 7 (Rect Shoe)
Now allow damper holes to exist even if the damper is not cut.
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CID 73, 99, 100, 863, 869 (Breeches (various), Trouser)
Double Wall representation fixed on variations of Circular Breeches.

CID 818 (Circular Box Shoe on Straight)
Connector 5 added for the reducer to join to body of the fitting.

CID 838 (Hanger)
New options added to CID 838 to enable the display of "Siesmic Rods". When the pattern's "Type" option is set to "Clevis 
Hanger", new option fields are displayed to show/hide the item's Front, Back, Left & Right "Seismic Rods".
New options added to CID 838 to enable the display of "Siesmic Rods". When the pattern's "Type" option is set to "Profile 
Bearer", new option fields are displayed to show/hide the item's Front, Back, Left & Right "Seismic Rods".
Wrap‐round type: new dimensions added to configure the rod as rectangular bar, if width, depth and length supplied.

Support added for new types: stirrup (half oval), split ring (full oval), double profile bearer.

Wrap‐round circular type; added a rect. box option on top of rod, which creates a CAD node for the top center of box.

CID 839 (Circular Box on Straight)
Added reducer options to apply onto the main body and a connector 5 for joining.

CID 845 (Elliptical Reducer)
Now supports double wall.

CID 859 (Cowl)
Added connector (didn`t have any).

CID 879 (Electrical Cable Tee)
Option added to draw the Throat Type as Radius or Flat when configured as Wire.

CID 894 (Hard Offsetting Cross)
Removed branch width/depth limit (minor<major), enabled double wall.

CID 898 ( Cabinet)
Added the ability to orbit in the takeoff dialogue.

CID 914 (Rect Smoke Damper)
Added option for chevron(s) i.e. option to display in plan & elevation views.
Fixed annotation  wrongly positioned if dims sides/bottom/top (K/L/M) not zero, as were the various symbols on its sides, and 
certain handle types.

CID 935 (Circular Offset Reducer Cross)
Now allows branch 2 zero diameter/length to disable, added branch rotations.

CID 985 (Beam Strut)
Option added to input total length.

Application Fixes

3D Viewer
Fixed DXF import method to obey colour/line styles/line weights when importing underlays into the 3D Viewer.

Fixed monochrome underlays (rasters) to display correctly as previously showing background colour to be transparent.
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Fixed the Takeoff colour, colour mode in the viewer (it was displaying the items in black which it should not have been).
Changed the colour mode toolbar button from a 5 state button (ie. each click on it changes to the next colour mode) to a popup
menu.
Fixed window selection procedure in the 3D viewer to ignore snaps

Stopped the 3D Viewer from crashing when closing the 3D viewer when the "prompt" was visible.

Fixed viewer not displaying design line or objects due to colour blending issue when importing raster underlays.
Fixed coupling when "Cut In" to straights. Now takes into account the correct length of coupling and seperates the straight to 
suit.

Ancillaries
Fixed price list / fabrication / installation ancillary links being wiped if ancillary kits were defined.

Auto Backup Job
Fix auto backup job at key points being disabled.

Automatic Nesting
Resolved issue with nesting as it was causing a crash at the end of nesting routine due to attempting an update auto quantity 
on filler items. These items are imported from CAD but are forced not to develop its parts.

Centre of Gravity (COG)
Centre of Gravity command was reporting out some Valves incorrectly, 0 area faces were affecting the calculated points.

Common Line Cuts
Fixed program crash when Writing NC
 and the nest contained parts with Common cuts

Database permissions
CadDuct Setting page of the Database was always being saved when the user selected OK even when they had restricted access, 
i.e. no permissions set with mapuser.
This was only an issue if using the TOGGLEPOSITION command to modify the position for text, it would get saved if the 
database was edited.

Design Line
Offset rules: was incorrectly placing back‐to‐back rectangular elbows on oval lines.

Fixed issue with not being able to select access panels or hanger type nodes.

Fixed issue with complex nodes not filling in correctly. Fix introduced to stop the straights overlapping the complex fittings.
Fixed an issue with eol tee's that use straight, shoe, cap end type combination. Was failing to place product listed cap ends ‐ 
was still doing straight & shoes though.
CID 1108, 2108, 3108 (Hosepipe) ‐ fixed this pattern causing the software to lock up ‐ only experienced the issue with design 
line filling.
Fixed crash in design line if item flex adjoined to is invalid.
Hangers and cap end placement on "dropper lines" wasn't working correctly, ie where the line's fittings have been allowed to 
be displaced by e.g. an offsetting tee.
Applied fixes for how complex nodes behave particularly between sessions.
Added logic to allow unfilled complex nodes to be filled by a bridging pattern if there is one available.
Fixed issues with offset rules and electrical offsets where they had been filled the wrong way round

Add riser logic amended ‐ so that lines are added correctly.

Fix for dummy terminal logic, should now be able to add a riser starting at an existing cad node.

Dimension Styles
Dimensions now obey the Leader Type in the text style.
There is also a new option in Dimension styles to suppress the dimension reference lines.

Ductboard
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Changes made to oversized Ductboard patterns introduced so that developments are assigned particular machine tools to
perform best seaming convention.
Applying Large Seams to Developments
Global change to the software that attempts to join nearby elements. For example the Ductboard Breeches where arcs need to
be joined to a series of lines, each line being much shorter than ductboard thickness.

DXF Import
Change made to only map the entity colour from AutoCAD to RGB colour if colour value is specified in the file. This is to prevent 
the entity colour mapping to white and therefore be hidden.

Edge Nesting
Fixed Edge Nesting routine that was allowing parts to be nested off the sheet when multiple sheets were used.

IFC Support
Make standard IFC Export use less memory by writing directly to a file rather than Memory. Additionall fix issue of crashing 
when more that 1000 objects selected.

Insulation Specification
Fixed Insulation Specifications being carried over from catalogue items with Insulation Specifications locked against them.

Fixed inconsistencies in changing insulation specifications and the redevelopment failing.

Fixed insulation specs carrying over locked values from catalogue items.
Fixed inconsistencies in changing insulation specs.
Implement change specs in 3d viewer.

Item Area & Weight
Fixed issues with refresh after editing item areas and weights. Values had previously not been getting updated.

Item Reports
Rectified issue with Item Sealant print object properties showing multiple indexes, this now only has the 1 sealant per item as 
it should.

Item Scripting
Resolved issue when developing Rectangular Taper patterns usig the item.update()

Memory Optimizations
Various aspects of memory utilization optimized for efficiency, resulting in reduced amounts of system memory used when 
nesting and printing,

NC Writing
NC Cut Order ‐ Tool By Tool
Fixed tool by tool mode not appearing to be applied to NC if only one tool is used in each section of the island. Problem shows 
if cutting ductboard and the seam tool cuts through.
Fixed unwanted tool changes when writing NC in Tool by Tool mode. Problem with Cut Order identified whilst cutting Ductboard
when some of the developments have been mirrored.

OPUS
Fixed missing cursor if menus are activated via the keyboard.

Part Slicing
Oversize Break ‐ fixed error reported when slicing in profiler. Was going wrong when slicing Rectangular Bend cheeks between 
air turn track. Was due to attempts to keep the pierce points as close as possible to the original points.

Pattern Icons
Fixed potential issue where icons didn't get refreshed properly in job contents / job browser / item folders when combinations 
open at the same time.
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Pattern Takeoff
Rectified memory  issue when developing or redrawing Segment bend patterns

Post Processor
Diams Post Processor ‐ DIAMSGEN.VPL
Fixed post to  force deceleration to be enabled at the end of every cut. DEC_OFF now never appears in the NC file, regardless of 
Corner Slow Angle setting.
ATTGEN.VPL ATT Post ‐ 1.) Applied Sheet Sensing at every cut start 2. ) Added in Hungarian remarks 3) Disabled MAP remarks.

RAPIDGEN Post Processor ‐ Add Special Features "Block Numbers" and "Mach3 Codes".

Product lists with "Auto" length
Product listed items using "Auto" for length were filling in the "Auto" value with the length from the specification, which meant 
when changing spec or size which dictated a different length, the pattern was not updated to the new value. Applies to Pipe and 
Duct.

Report printing
Fixed memory leak in report printouts that are grouped into tables.

Scripting
Scripting enhancment to stop erroring out when using "EndLocation" method and requesting an invalid connector number. (i.e. 
CID 891 Connector 5)

Sub Assemblies
Resolved issue with sub assemblies with holes when a new dimension added. Now changed the dimension reference to work 
from the UID rather than indexes.
Fixed sub assemblies including wrapped items not displaying in the takeoff dialog (and possibly in AutoCAD).
Fixed product listed sub assemblies not drawing correctly for sub‐items that use Pipe OD's (spec not being applied to sub 
items)

Support Emails
Fixed potential crash when sending support email.

View Menu
Fixed View menu being disabled in takeoff, not just for standard parts.

Viewer: Item Annotation
Item annotation in the viewer (bottom of duct, duct size and item number) now draw their leaders.

Pattern Fixes

CID 1104, 1117, 1118 (Oval Tees)
All 3 patterns had same connector assignment which was only valid for 1104. Fixed connector assignment for 1117, 1118 and 
in 1118 this now uses C4 and C5 at joints between main pipe and reducers

CID 1115 (Oval Straight with Branches)
If branch slope angle 0, develops with collar attached, not separate, and reversed direction of branch tilt (whilst maintaining 
compatibility).

CID 1115, 1116, 1118 (various: Oval branches on oval)
Minor corrections to reducer connectors, fixed 1118 incorrect double wall when dimensions were calculated.
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CID 1118 (Oval Tee with Splitters and Reducers)
Fixed connectors 4 & 5 were getting sizes of connectors 1 & 2, fixed showing Dimensions/Options for all 4 branches when only 
one enabled.

CID 1119 (Oval Breeches)
Fixed the ability to have an angle less than 45 degrees.

CID 1129 (Twin Straights)
Add method to ensure that the parent item has decoiler info, to prevent crash on Accept following console command "makepat 
1129"

CID 1131 (Ductboard Reducing Straight with Bend)
Fixed bottom width of cheeks which had been applying additional material thickness in the developments.

CID 1145 (Ductboard Slot Plenum)
Fixed to only allow the material thickness adjust to the wrap part development when the fold is on the upper surface of the 
board

CID 127 (Plate with Holes)
Fixed hole positioning away from the plate edge; now allows you to position holes using the X, Y Offset, the minimum value is 
the radius of the plate holes.

CID 134 (Oval to Square with Extension)
Fixed length annotation value to coincide with length entered

CID 14 (Breeches Piece)
Resolved issue with pattern's extension being double the input value.

CID 18 (Side Branch)
Fixed inside insulation, was being drawn using two points from outer wall instead of the inner.

CID 2 (Rectangular Taper)
Resolved issue with lost notch when Part Labels on Inside option enabled. Also re‐alligned 3D perspective so alligned 
centrally.

CID 207 (Offset Ring)
Resolved issue with pattern generating "Bad Dimension" warning on initial creation.

CID 2097 (Circular Bend)
Fix in place for when using centerline input on this pattern. Was causing center radius to report negative value as was not 
using diameter type = nominal. Was using Outer diameter and therefore being drawn incorrectly.

CID 2882 (88‐Curved‐Branch + Access)
Fixed bad dimension annotation if collar 'Auto'.

CID 2938 (Twisted Cross)
Fixed twist angles that were previously getting converted into imperial measurements

CID 31, 382, 956 (Grille Boxes)
Fixed Item Connector Duct Depth #2 being displayed as 10000000 in Job Contents Items view if hole type is set to Round.

CID 32, 150 (Straight with Branches)
Added new options to control connector fold notch at C2 end when set to Use Vee Notch as currently only allows C1 end 
control.
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CID 324 (Twisted Angled Offset Square to Round)
Fixed initial MAKEPAT dimensions.

CID 328 (Rect. Trousers)
Fixed the incorrcet display/development of double wall.

CID 330 (Radius 2 Way Offset)
Fixed Depth Out dimension which was incorrectly adding as annotation as opposed to a dimension

CID 360 (Oval 3 Way)
Amended the initial 'makepat' dimensions; stops the "Invalid dims" warning when applying the double wall option.

CID 365 (Tap on Oval Elbow)
Fixed hole development position when opting for Oval Tap or changing the seam position.

CID 398 (Sliced Lagging Tee)
Fixed flat branch sections creating problems with the model views and developments.

CID 65 (Branch on Round)
Resolved issue with CID 65's dimension placement for the "Right Exrension"

CID 7,  9, 44, 875 (Circular Branch on Straight)
Amended the branch lengths MAKEPAT dims, so ok if double wall enabled.

CID 835 (Breeches 2 Way)
Fixed bad dimensions when small right height and large right radius (arcs joined faces passed outside/below inner arc).

CID 838 (Hanger)
Stirrup and oval depth dimension is now total depth (oval diameter instead of radius); removed cad nodes for both left & right 
straps.

CID 842 (Oval Cross Offsetting)
Fixed connector #2 using connectors from the Circular group, now uses the correct Oval group
Added option to enable branches to rotate onto flat of Oval.

CID 866 (Decoiled / Plasma Cut Straight)
Add method to ensure that the parent item has decoiler info, to prevent a crash on Accepting following the console command 
"makepat 866".

CID 895 (Easy Offsetting Saddle)
Removed branch width/depth limit (minor<major), branch double wall sometimes missed intersections resulting in only a 
single branch (giving bad dims error).

CID 925 (Oval Reducer + Branches)
Resolved issue with this pattern causing the application crash when opening.

CID 926 (Plenum Box)
Resolved issue with holes added to pattern's left & right side, not using offset value.

CID 927 (Filter Box)
Fixed seam cutback on connectors which now has the angle applied.

Not all seams had the angle applied to them, was missing some seam cutback from connectors.

45 58ofPage



Software Changes Document: CAM‐Duct

In "Edit Developments" the extents area was over 20000000000; fixed by ensuring the developments contain no empty sections;
is only fixed after an edit pattern and redevelopment.
Pattern Developments with Angled Seams.
Added an optional validity check, used when pattern developments set angled seam start/ends, to prevent possibilty of seam
angles being wrongly applied to a previous section.

CID 942 (Ductboard Taper)
Fix upper / lower fold lines being reversed.

CID 946 (Ductboard Rectangular Breeches)
Fixed throat development length which was not compensating for material thickness.

CID 947 (Ductboard Shoe)
Back wrapper develop Y size was wrong (was adding twice material thickness)

Fixed the back wrapper development Y size as this was adding double the material thickness.

CID 955 (Ductboard Mitred Offset)
1. Fix upper / lower fold lines being reversed on wrappers
2. Add correction for thickness at folds to wrappers

CID 959, 1148 (Rectangular Tapers)
Fixed V notch options being ignored as it had been using Pattern Options database default notch setting.

CID 970 (Circular Reducer (Add Hole))
Rectangular branches had no cad nodes, oval/rect branches width/depth dims swapped, was also losing connectors when 
saved/reloaded, moved oval/circ cad nodes from branch base to end.

CID 994 (Extruded Item)
Fixed so if using the "Mirror" Option, points on the part are now reversed.

Pattern developments
Oval branches on oval: fixed the development of branch parts/seam positions to account for oval branch`s flats having had 
extra points inserted; used by CID's 1104, 1115, 1116, 1117, 1118.

46 58ofPage



Software Changes Document: CAM‐Duct

2.38.089 17MAP Software Version: Version LOK Code : Release Date : 29/05/2009

New Features

CID 866 (Combined Straight)
Added new option to CID 866 to override the Cut Type that is assigned from the "Straight Database", which allows additional 
control from scripting.

Post Processor
Changes made to apply new stop and start codes that can be implemented by the GoMech post processor.

Application Fixes

File Export
Fixed Export of Binary XML, was parsing some characters incorrectly.

IFC Import/Export
Fixed all imperial IFC import/export files to scale the contents of the file so they are always metric (mm).

Input Units
Fixed toggling the units in pattern takeoff not converting the dimensions.

Installed Machines
Fixed the  default machine being lost on setups where the default machine is not the 1st detected machine, is not 'installed' i.e. 
In the Database folder but not added to a Group, or is otherwise invalid.

NC Writing
Fixed the Kerfing that was being applied to holes that became smaller than the applied Kerf and comparing the hole size to 
pierce or ignore sizes.

Program Crash
Fixed CID 970 (Reducer + Add Hole) causing crash in PM2000 when being taken off in Quick Takeoff mode.

Scripting
Elevation Scripting objects that reported Top and Bottom were not taking into account Pipe OD's.

Straights (Stiffener Qty)
Fixed small length straights getting the wrong stiffener qty costed for nomalisation (was using full un‐decoiled length, not 
broken down lengths to calculate).

Sub Assembly
Fixed sub assembly editor not allowing user to change item properties in item folders,  fixed crashes in item folders when they 
are edited (especially from outside the program), fixed drag/drop item folders.

SysScrReport
SysScrReport command does not work on 64 bit machines (Microsoft JET 4.0 is not supported), now exits gracefully when 
cannot create the file.
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Takeoff
Fixed toggling units in takeoff resetting altered dimensions to the previous values, unless the redraw command was used.

Pattern Fixes

CID 1118 (Oval Conical On Oval)
Fixed bad geometry by calculation (e.g. C = F+100) when changed from metric to imperial.

CID 1122 (Ductboard Drop Cheek Bend)
Area calculation was being doubled up due to error in a general routine used to convert metal cheek developments to 
ductboard. Also affects CID's 944, 946, 950, 951, 1121, 1131.

CID 1141 (Castellated Bend)
Segments only had castellation on each segments' first part when the cross break option was greater than one.

CID 18 (Side Branch)
Fixed issue were the inside insulation was being drawn using two points from outer wall instead of inner.

CID 33 (Straight + Shoes)
Fixed missing Connectors on the Straight (version 2.38.076 dropped connectors).

CID 356, 359 (Oval Straight with Round Branch(s))
The round connectors were being displayed as oval with depth of 0. Now include missing branches connector annotation.

CID 378, 1116 (Oval Cross Shoes, Oval Shoe Cross with Reducer)
If pipe is oval and "Allow Branches On Flats" option was set to Yes, branch holes development was positioning the holes 
incorrectly.

CID 802 (Cap End)
Now allows "Mirror" option as per CID 12.

CID 866 (Combined Straight)
After adding holes, the hole options were being lost when the item was saved and reopened.
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2.38.079 17MAP Software Version: Version LOK Code : Release Date : 22/04/2009

New Patterns\Enhancements

CID802 (Cap End)
New option added to enable the item to "Mirror" when fixing

Application Fixes

Connectors (Swage Set Back)
Swage Set Back adjust on round connectors was not working with REAL numbers (numbers with decimal points), the number 
was being rounded to a whole number, i.e 0, 1 or 2. Was noticable in Imperial database when the setback would either be 0" or 
1".

NC Writer ‐ Hole Piercing
Resolved an issue with smaller holes not being set for piercing when applying kerf. Calculation to regrow the holes that 
become smaller than the kerf value has now been adjusted and now pierces small holes successfully.

Scripting
Application fix to resolve issue with scripting objects that reported Top and Bottom of items, were not taking into account Pipe 
OD's.

Pattern Fixes

Area Calculations
Fixed area calculations on Ductboard patterns CID 1122, 944, 946, 950, 951, 1121 and 1131.

CID 33 (Straight + Shoes)
Resolved issue with pattern missing connectors.

CID378 & 1116 (Oval + Shoe)
Resolved issue with pattern's hole developments being incorrectly positioned.

CID521 (AHU Pattern)
Dimension checking relaxed, holes can now be positioned off the main body of the pattern.

CID866 (Dual Purpose Straight)
Resolved issue with adding holes to pattern, the settings were not displayed when the item was saved and then re‐opened.

CID970 (Circular Reducer)
Resolved issue with application crashing when CID970 was taken off in "Quick Takeoff" mode.
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2.38.077 17MAP Software Version: Version LOK Code : Release Date : 09/04/2009

New Features

Item Scripting
1. Added scripting option to report Top and Bottom of objects end position item.endlocation("Top") item.endlocation("Btm")
2. Added scripting option to report items section levels item.level("Floor") item.level("Soffit")

New Patterns\Enhancements

CID866 (Dual Purpose Straight)
New option added to draw the Model at the entered length (Lengths Include Connector Adjust) when using "Step Down" 
connectors, the development still includes the full turnover, the 3D model will shorten the length by Line4 allowance.

Application Fixes

Service Database
Resolved issue with"Lineweight" display in services editor, was defaulting to metric (mm) after selecting an imperial value.

Pattern Fixes

CID 521(AHU Pattern)
Relax new Dimension checks for CID 521, in 2.38.076 latest release it was not allowing holes/openings to be positioned off the 
main body.

CID134 (Square to Oval)
Resolved issue with annotation line displaying at the incorrect length.
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2.38.076 17MAP Software Version: Version LOK Code : Release Date : 07/04/2009

New Features

3D Viewer
Line weight settings moved from "Line Styles" to Service Database CAD Types.

Added feature to apply Centre of Gravity grip point using the following command: COG.

Camera Add and Rename icons enabled in the "Global" tab, previously only enabled in other tabs.

"E‐Links" can now be offset and orientated within the 3D Viewer
Added new options for "Filter" selection sets in the 3D viewer. Enables selection sets to be created on item properties that can 
then be used for collision detection, isolation etc.
ADDTEXT command, user can now edit any text and its size which has been placed in the 3D Viewer.
SetZ, new command to allow an object(s) to be moved to a user defined Z value in the model. Multiple objects of different 
heights can be selected and moved to a common Z value defined in the command
ZIP support added for read/write IFCXML

Design Line
New feature added to Hanger Specifications for use with Design Line, option added to apply before and/or after joint positions.

Pressure Drop Dialog: Added facility to apply a source pressure to evaluate real flows for circuits.
Editor dialog
Can now select lines using the select lines button in CAM.
Pressure Drop Calculations: Added a 'Calculate Actual Flows' option, with this ticked the non‐index run circuit flows are 
adjusted to balance the pressure losses in the index run. This will increase the flows in the terminals so that each circuit has 
the same pressure loss as the index run. A side effect of this is that the index run pressure drop will increase because of the 
increase in source flow.
Use of dampers on the non‐index run circuits to limit the flow on the other terminals will restore the original index run 
pressure loss.
Optimisation of Design Line Pressure Drop calculations to improve efficiency.

Added the ability to add eccentric reducers to form part of a non‐centre line tee.
Added "Auto Elevation" update mode.
With this enabled on the Design Line interface changes in fixby to or from centreline amend the working elevation 
automatically.

Import Underlay
Support added for the following: leader line, arc to polyline, table & Trace(2D face) imports.

Improved "Import Underlay" to bring in 3D ellipses as polylines
Add conversion of unicode symbols in Text
eg \U+00B0 converts to  ° (degree symbol)

Lockformer 1000D
Added support for reading the Imperial wire gauge from the Material Database.

Pattern Development ‐ Connectors
Expansion of connector slit logic in the Pattern Database ‐ Options to cope with making an integral flange complete with bolt 
holes (For very heavy duty ducts to save welding).

Pattern Type
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Pattern Type of "Rectangular Duct" added to the following CID's
CID 1120 (Taper + 2 Bends)
CID 1130 (2 Bends)
CID 1131 (Taper + Bend)

Post Processor
Bystronic Post Processor ‐ BYGEN.VPL now defaults to metric units, added ability to select metric units with line 
(Units="English") at the start of file.
Burny Post Processor ‐  BURNYGEN.VPL
Added option for plasma marking using either Marker 1 or Marker 2 commands, controlled by the Post number.

Price Lists
Added support to convert SET for per qty and REEL for per ft/m as recognised tags when updating price lists.

Print Objects
New print objects added for Item material, Skin and insulation colour.

Scribe Font
Have added the diameter, degree and +/‐ symbol (±°Ø) support to the scribe font.

Service Database
New option added to "Service Database" to enable user to apply which Status fields can be output to ESJ/MAJ files, when 
executing the export to CAM function.

Splitter Tabs
Splitters now support the addition of "Tabs" on developments, options added to splitter setup in Pattern Database to set tab 
width, length and quantity. Note: CAD‐Duct users can access this in Full Database Edit mode.

Sub Assembly
Improved support for “Sub Assemblies” in Design Line.

VPL/DPL
Added 64bit versions to all VPLs and DPLs

Write NC
Added support for passing the number of round sections for development to the Post Processor.

New Patterns\Enhancements

CID 32 (Straight + Branches)
Now supports double wall.

CID 328 (Trouser Piece)
Now supports double wall.

CID 33 (Straight + Shoes)
Now supports double wall.

CID 836 (Radius Double Offset)
Now supports double wall.

CID 838 (Hanger)
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New option added to the hanger pattern to draw a circle at the top of the drop rods representing the"Area of Influence", i.e. no
go zone, the symbol is drawn onto the 2D layer.

CID 996 (Terminal)
Added option to suppress all Symbols drawing on CID 996 (set Option 0 to "None").

CID1133 (Rectangular Straight + Integral Reducer)
New Rectangular Ductwork Pattern, options include: setting angle of damper blade, item developments which include fixing 
holes for blade.

CID1141 (Segment Bend + Spacing Tabs)
Round segment bend made in single segments with options to add small spacing tabs along the connector and seam edges.

CID1142 (Ellipse)
Ellipse pattern

CID12 (Rectangular Cap End)
New Option added to pattern to enable the part to be mirrored, this ensures that it will always attach to the straight.

CID183 (Lagging Straight + Cut Out)
Added new option to enable the addition of a hole with angled sides.

CID521 (AHU Pattern)
New option to draw an Attenuator symbol on item.

CID764 (Filter Box)
New "Filter Box" pattern.

CID765 (Louvre Box)
Louvre Box pattern.

Ductboard
New pattern CID 1136, Plenum Box, based on current pattern 926

New Pattern
Added new pattern CID 1145, Duct Board Slot Plenum

Added new pattern CID 1144 TriPro Damper

Application Fixes

3D Viewer
Fixed imported DWG files, with text containing upper case %%C, not being converted to the diameter symbol.

Fixed bug which was causing underlays to mask out other items in the 3D Viewer.

Resolved issue with annotation not applying correct colour from CAD‐Types in the Service Database e.g. Levels, Sizes etc.
Improvements made to printing from the 3D Viewer, this feature is dependant on the user's printer dpi and graphics driver 
capabilities.
Resolved issue with branches breaking the pipe when "Cut In".

Fixed program crash when using annotation and cadview.map file does not exist in the installation directory

Resolved issues with DIMO & DIMA commands not drawing the dimension lines and arrows when executing these functions.
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Fixed a bug in CircDoubleBend (CID 2155) causing application crash when viewed in 3D viewer, if rendering via shells.

Application fix to resolve the mapping of screen colours to paper colours when printing from the 3D Viewer.

Resolved issue with "E‐Links" not functioning correctly in layout views.

Resolved issue with text in "Dimension Styles" dialog displaying 7326 rather than displaying dictionary text.
Import Underlay, issue resolved to fix the import of DWG layer handling so that lines, arcs, text etc are assigned to the correct 
layers.
Resolved issue causing application crash when using "R" to rotate item when applied with "Cut In" command.

Fixed application problem caused when applying annotation to an item.

Resolved issue with "Selection Sets" not functioning correctly with objects within "E‐Links"
Fixed text placement and text colour when importing from DXF files. The text colour will now use the layer colour in preference 
to the global line colour.
When importing a DXF/DWF/PDF the layer selection dialog could display negative colour values if the user clicked on either 
the invert selection or deselect all buttons.

ARTGEN2 Post Processor
Fixed broken NC when using non router based tools, e.g. plasma.
Tools were not being selected and arcs had wrong centres.  Caused as a side effect of changes made for the ductboard 
machine.

Calculated Dim Fields
Fix change not to show hidden dimensions on pattern dim calcs breaking calcs + show correct annotation when drawing part 
developments for skin + don't show bad C3/C4 annotation for double wall connectors in takeoff views

CAM‐Lite, Radan
Fixed a bug in CAM‐lite, Radduct, and Almaduct where the user was unable to save or load the Job File (MAJ).

Decoiler Setup
Decoiler data was not being loaded into the Database at start up; the code got dropped unintentionally when database profiles 
were revamped in August 2008.

Design Line
Resolved issue with "Overridden" bends not filling when placed on a "Flex Filled" Design Line.

Resolved issue with Design Line "Auto Fill Hangers" feature, updating the job. This was effectively causing a regen each time.

Improved shoe placements in Design Line, particularly for angled branches and non centre line tee junctions.

Resolved issue with Design Line placing an incorrect shaped Cap End into the system.

Resolved issue with Change Units option on terminal from wiping out the unit description.

Improvement to Design Line fill routine for inline tees, will result in less branches bridging over more than one straight length.

Double Wall (Straights)
Fixed Double Wall straights when set to Auto length,  ending up with different skin / body finished lengths if the connector 
turnover' allowances were different.

Download Programs
Resolved issue regarding download programs not sending all of the data to the controller, especially BURNY systems.
Disabled the warning message on download programs when data can not be added to the transmit buffer within a certain time 
limit.

Ductboard
Fix handling of ductboard parts which only have a single outer island, and the island has seam edges e.g. Grille Box lid. This 
was causing 0 area, overlap, unable to pickup part on nest, and possible non drawing of outer 
island when selected.
Fixed area calculations possibly appearing doubled with some ductboard tool settings.

Fixed a typo causing Ductboard seam islands to still be wrongly included in the area calculation.
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Ductboard Options
Ductboard Options
Application fix when applied fold marking lines ‐ last line was missing in two pass mode, all lines were missing in single pass 
mode.

Firmac Interface Utility
Changes made to the FIRMAC.EXE download program.
1) Disabled job refresh rate and now only refreshed when link is opened/re‐opened.
2) Fixed job list view showing incorrect job names after refreshing.
3) Added a small delay after updating job information to PLC to reduce repeated sends of data.
4) Program will now save job files status when the link is closed.

Item Takeoff View
Fixed issue with insulation/double wall using the CAD‐Type colour defined in the Service Database. The item now uses the 
"Faces" colour defined in item's takeoff properties.
Application fix to resolve issue with Item’s Takeoff view not using the material’s colour if specified in the settings, fix also 
applies to graphical view in print objects i.e. Item view in worksheets.

MAP Backup
Improved error reporting when selecting zip file to restore, now prompt auto‐popup browse dialog if not zip not found. Added 
support for profiles and new import/job file types.

Nesting
Manual Nesting: Fixed application crash if ctrl A was pressed to select all parts if no parts were on the sheet.

Pattern Database
Resolve issue to reinstate option to setup default tool for "Bottom Seaming"

Pattern Dependencies
When applying a Dependency to a dimension, restrict the list of available dimension descriptions to the ones used by the 
pattern, instead of all dimensions used by the Master pattern.

PDF Import
Resolved issue with PDF import using clipping rectangular paths as actual paths.

Print Objects
Resolved issue with "Dimension List" object not obeying "Show Real Values" switch, for example if Straight pattern is set to 
"Auto", switch displays item's actual length value in reports.

Scripting
Resolved issue with application crash when script file was re‐using a variable that was getting deleted.

Spool Reports with Sub Assemblies
Option to "Expand Sub Assemblies" when using Spool Reports was not enabled in the dialogue, now user has option to expand 
or not. Expanded will report each item within the sub assembly on a new line. (unless collected).

Worksheets
Fixed scaling issue and print quality when printing from Worksheets.

Write NC
Part Start Logic ‐ Pathfinder Post
added test for same part (item multiple quantity) being written consecutively at different positions on the sheet. This is 
required so that part start logic can be called at the start of every part e.g. block numbers in Pathfinder Postprocessor.
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Pattern Fixes

CID 1 (Straight (Cut))
Fixed bug that was not cutting holes in insulation when applied to this pattern.

CID 1120, 1130, 1131 (Ductboard 2/3 Way)
Fixed cheek developments so that they are no longer too large by thickness in Y direction. Added error check for bottom 
extension less than thickness.

CID 1129 (Twin Straight)
Auto‐length was not functioning.

CID 183 (Lagging Straight with cut‐out)
Fixed this patterns development; being split into two unequal‐sized parts.

CID 2882 (88‐Curved‐Branch x 2)
Fixed missing second branch since implementing proper intersections.

CID 3 (Square Bend)
Fixed holes being positioned incorrectly when offset around the bend`s corner and using double wall.

CID 33 (Straight + Shoes)
Fixed the right hand side hole development being positioned incorrectly (offset).

CID 37 (Drop Cheek Breeches Piece)
Bottom cheek development reported break down when should have been break up.

Note: issue only occurred in versions 2.37.163 to 2.38.050

CID 382  (Grille Box Variable Hole Options)
Did not have correct hole position limiting, was unable to place holes touching the face edge.

CID 382 (Grille Box Variable Hole)
The default hole was using just the hole width dim for its width and depth, now supports the depth dimension to allow for Rect, 
Round, and Oval holes.

CID 45, 46, 943, 954  (Ductboard Bends)
Fixed mitred throat developments generating fold lines as per the radius throat.

CID 7 (Rectangular Shoe)
Double wall (skin and dims inside) lower end was not cut back, made to match top end.

CID 93, 325 (Bullnose Tee)
Removed C4 connector annotation from pattern views.
Fixed problem when developing part using the Option to develop in 2 Parts = Yes and when showing marking lines on 
development screen.

CID 947 (Ductboard Branch)
Fixed Pen Mark seam edge development when made in 2 or 3 parts.

CID 952 (Ductboard ‐ Square Bend)
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Fixed Pen Mark seam edge development when made in 3 parts.

CID 957 (Grille Box Side Entry)
Added holes' inset/offset bad dimension check (previously would allow holes of the side of the pattern).

CID 96 (Lagging Dome)
Pattern fix to resolve problems with segment development when adding fixing holes and making extensions as separate parts. 
Resolved issue with holes being placed off the item and placing on top of each other.

CID 996 (Swirl Diffuser)
Relaxed the dimension checking errors when pattern 996 is configured as a Swirl Diffuser. It now allows the Width and Depth 
to be 0 x 0 (No plate).

CID1115 & 1116 (Oval + Branches)
Resolved issues with CID1115 & 1116 developing incorrectly if body of item was set to round.

CID121 (Oval Branch)
Resolved issue with CID121 displaying incorrectly when double wall settings were applied.

CID184 (Circular Bend on Straight)
Resolved issue with item not displaying centre radius and angle annotation on takeoff view.

CID326 (Segment Bend + Round Tap)
Resolved issues with incorrect hole positions and application crash when part was developed.

CID365 (Oval Bend + Round Tap)
Resolved issue with CID363 developing incorrectly when tap size was equal to the body size.

CID889 (Oval Branch on Straight)
Resolved issue with pattern being adjusted for "Double Wall" if the branch width/depth/length was set to zero, this resulted in 
an extra skin being created.

CID931 (Sliced Box Tee)
Fixed application crash if CID 931 was developed with branch parts set to 2 and marking lines on.

CID968 (Archimedes Screw)
Resolved issue with part developments cutting wrong way round compared to convention, allowing parts to overlap on nesting.

Ductboard
Added lengths for fold lines on "Throat Wrapper".

Added fold line's angle and extra development lengths for folding.

Resolved issue with CID944 (Ductboard Radius Offset), reported seam edges being cut twice on "Pathfinder" controller.
All Ductboard patterns now have following pattern types: Rectangular/Ductboard. Dongle type of all Ductboard patterns now = 
Ductboard.
Fix marking errors in Radius Bend throat wrappers when the option for "Throat Type" was set to Mitred.

Fixed errors in marking Radius Offset wrappers.
CID 1124, 1129 (Ductboard –Twin bend & Parallel Straight): added Patterns Connector Split‐Dims, so patterns select gauge 
using split connector sizes (bottom connector’s individual elements size, not connectors full size).

Ductboard Part ‐ Area calculation
Use theTool selected in Pattern Database Ductboard Setup, when checking for ductboard seam islands, to calculate Duct Area

Ductboard Patterns
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Recent change to include ductboard seams in costing caused possible multiple section annotation texts which were
superimposed and unreadable, added ductboard tool numbers to sections to enable create section annotation texts for the first
island only.

Ductboard Patterns ‐ Area calculation
Fixed typo causing ductboard seam islands to be wrongly included in area calculations.

Grille Box (CID 31)
Dimension checking for Holes was allowing invalid positioning, the Hole Inset and Offset were incorrect.

Grille Box (DuctBoard)
CID 957 ‐ Ductboard Grille Box 2.  Fixed one of the groove fold lines being lost from the development also fixed the bevel edge 
marking line being positioned right at edge of the part when it should be a material thickness away.

Insulation and Edge Lines
Insulation and edge line fixes for the following patterns: 46, 189, 317, 347, 348,  349, 350, 351,352, 353, 369, 390, 828.

Pattern Change
CID 184 (Segment Bend on Tee)
Bend height annotation was being measured incorrectly from the bend centre instead of from the pipe center
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